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Uvod

Zahvaljujemo što ste Medtronic Diabetes odabrali za partnera koji će i  vama i bolesnicima

olakšati liječenje dijabetesa. Vjerujemo da ćete imati koristi  od vrhunske tehnologije softvera

CareLink® Pro i jednostavnog  korisničkog sučelja kojim se upravlja putem izbornika.

CareLink Pro omogućuje prikupljanje i pohranjivanje podataka o liječenju i dijagnostičkih

podataka te izvješćivanje na temelju tih podataka. Možete ga koristiti i  za pristup podacima o

glukozi dobivenima od pumpe, mjerača i senzora koje bolesnici prenesu u CareLink® Personal,

mrežni sustav za praćenje terapije koji funkcionira u suradnji sa softverom CareLink Pro.

Značajke

CareLink Pro jest softver za osobna računala namijenjen praćenju terapije za dijabetes.

Raspolaže sljedećim značajkama:

• Zapisi o bolesniku mogu se stvarati radi pohrane podataka prikupljenih iz bolesnikova

uređaja, kao i podataka o liječenju s njegova računa u sustavu CareLink Personal.

• Podaci iz inzulinskih pumpi, monitora i mjerača glukoze u krvi mogu se slati sustavu,

pohranjivati i  zatim koristiti za generiranje izvješća.

• Postoji i mogućnost povezivanja sa sustavom CareLink Personal,  pri čemu se omogućuje

pristup podacima s uređaja koje su bolesnici ondje pohranili. To je idealno za stvaranje

aktualnih izvješća između posjeta liječniku te može očitavanje podataka s uređaja tijekom

posjeta liječniku učiniti nepotrebnim.

• Iz podataka s uređaja koji su pohranjeni u bolesnikovu zapisu mogu se stvarati razne vrste

izvješća o liječenju. Izvješća olakšavaju pronalaženje odgovora na pitanja u sklopu liječenja,

kao što su bolesnikovo pridržavanje propisane terapije, obrasci i  iznimke.

• Sustav vas obavještava kada su dostupna ažuriranja softvera koja možete preuzeti i instalirati.

To vam jamči da imate pristup najnovijim značajkama.

• Značajka Guide Me (Vodi me) početnicima olakšava korištenje softvera CareLink Pro. Ona

nudi savjete o zadacima koje obavljaju.
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• Integrirani sustav pomoći dostupan je u cijelom softveru i pruža informacije o specifičnim

područjima.

Sigurnost

• CareLink Pro može se zaštititi lozinkom.

• Prijenos podataka o bolesniku iz sustava CareLink Personal šifrira se pomoću standardne SSL

tehnologije.

Povezani dokumenti

Svaki od ovih dokumenata Medtronic MiniMed sadrži informacije koje su specifične za uređaj i

koje nisu detaljno opisane u ovom korisničkom priručniku.

NAPOMENA: informacije o mjeračima drugih proizvođača potražite u uputama koje se
isporučuju zajedno s mjeračem.

• Korisnički priručnik za inzulinsku pumpu Paradigm

• Korisnički priručnik za monitor koji prati podatke u stvarnom vremenu Guardian REAL-Time

• Korisnički priručnik za značajke senzora

• Korisnički priručnik za ComLink

• Korisnički priručnik za CareLink USB

Pomoć

Ako vam je potrebna dodatna pomoć s ovim sustavom, obratite se lokalnom predstavniku u

svojoj zemlji.  Informacije o međunarodnim kontaktima možete pronaći na sljedećem web-

mjestu:

http://www.medtronicdiabetes.com/help/contact/locations.html

Podržani uređaji

CareLink Pro prima podatke iz sljedećih uređaja.

NAPOMENA: neki uređaji koje podržava ovaj softver možda nisu dostupni u svim

zemljama u kojima je ovaj softver odobren za korištenje.
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Inzulinske pumpe / monitori glukoze

Pumpe Medtronic MiniMed: 508

Pumpe iz serije Medtronic MiniMed Paradigm®: 511, 512, 712, 515, 715, 522,  722, 522K, 722K,
Paradigm® Veo™ (554, 754)

Monitori Guardian REAL-Time:
CSS-7100

CSS-7100K

Proizvođač Mjerači glukoze u krvi

Partnerski uređaji Medtronic Diabetes:
• Bayer CONTOUR® LINK

• Monitor glukoze u krvi BD Paradigm Link®

LifeScan:

• OneTouch® UltraSmart®

• OneTouch® Profile®

• OneTouch® Ultra®

• OneTouch® Basic®

• OneTouch® FastTake®

• OneTouch® SureStep®

• OneTouch® Ultra® 2

• OneTouch® UltraMini®

• OneTouch® UltraEasy®

Bayer:

• Ascensia BREEZE®

• BREEZE® 2

• CONTOUR®

BD: • Logic®

Obitelj  proizvoda Bayer Ascensia® DEX®, uključujući ove
kompatibilne mjerače:

• Ascensia® DEX®

• Ascensia® DEX® 2

• Ascensia® DEXTER-Z® II

• Glucometer® DEXTER-Z®

• Ascensia® ESPRIT® 2

• Glucometer® ESPRIT®

• Glucometer® ESPRIT® 2

Obitelj  proizvoda Bayer Ascensia ELITE™, uključujući ove
kompatibilne mjerače:

• Ascensia ® ELITE™

• Glucometer ELITE® XL

Abbott:

• FreeStyle®

• FreeStyle® Lite®

• FreeStyle® Freedom®

• FreeStyle® Freedom Lite®

• Precision Xtra™

• TheraSense FreeStyle®

• FreeStyle® Flash®

• FreeStyle® Papillon™ mini

• FreeStyle® Mini®

• Optium Xceed™

• Precision Xceed™

Roche:

• Accu-Chek® Aviva

• Accu-Chek® CompactPlus

• Accu-Chek® Compact

• Accu-Chek® Active
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Komunikacijski uređaji

Com-Station

Koristi se s pumpom Medtronic MiniMed 508
Pump. (Pojedinosti o potrebnom hardveru
potražite u korisničkom priručniku za Com-
Station.)

ComLink

Koristi se s pumpom MiniMed Paradigm i
monitorom Guardian REAL-Time. (Pojedinosti o
potrebnom hardveru potražite u korisničkom
priručniku za ComLink.)

Monitor glukoze u krvi Paradigm Link®

Koristi se s pumpom MiniMed Paradigm i
monitorom Guardian REAL-Time. (Pojedinosti o
potrebnom hardveru potražite u korisničkom
priručniku za monitor glukoze u krvi Paradigm
Link®.)

CareLink® USB Koristi se s pumpom za inzulin MiniMed Paradigm
i monitorom Guardian REAL-Time.

Kabel za podatkovnu komunikaciju

Koristi se s mjeračima glukoze u krvi drugih
proizvođača. Svaki proizvođač mjerača isporučuje
kabel za podatkovnu komunikaciju.

Napomena: ako proizvođač mjerača za prijenos
podataka isporučuje USB kabel umjesto serijskog
kabela, morate instalirati upravljački program tog
proizvođača.

Uz to provjerite je li  upravljački program za USB
kabel proizvođača mjerača kompatibilan s vašim
operacijskim sustavom. Neki upravljački programi
za USB kabele možda nisu dostupni za 64-bitne
operacijske sustave.

Ekvivalentni uređaji

Prilikom dodavanja uređaja u sustav odabirete marku i model s popisa. Ako marka i model

uređaja nisu na popisu, u sljedećoj tablici potražite ekvivalentan uređaj koji možete

upotrijebiti.

Ako bolesnik koristi jedan od sljedećih uređaja Odaberite ovaj uređaj

• Bayer Ascensia® DEX® 2

• Bayer Ascensia® DEXTER-Z® II

• Bayer Glucometer® DEXTER-Z®

• Bayer Ascensia® ESPRIT® 2

• Bayer Glucometer® ESPRIT®

• Bayer Glucometer® ESPRIT® 2

Bayer Ascensia® DEX®

Bayer Glucometer ELITE® XL Bayer Ascensia ELITE™

Precision Xceed™ Optium Xceed™

Naručivanje

Obratite se lokalnom predstavniku u svojoj  državi da biste naručili  proizvode Medtronic

Diabetes. Informacije o međunarodnim kontaktima možete pronaći putem sljedećeg URL-a:

http://www.medtronicdiabetes.com/help/contact/locations.html
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NAPOMENA: mjerači se mogu naručiti od tvrtki koje ih proizvode.

Upute za upotrebu korisničkog priručnika

NAPOMENA: korisnički priručnik prikazuje uzorke softverskih zaslona. Zasloni stvarnog

softvera mogu se donekle razlikovati.

U rječniku potražite definicije pojmova i funkcija.  Konvencije korištene u ovom priručniku

definirane su u sljedećoj tablici.

Pojam/stil Značenje

Kliknite Kliknite lijevom tipkom miša iznad objekta na
zaslonu da biste ga odabrali

Dvokliknite Dvaput kliknite lijevom tipkom miša iznad objekta
na zaslonu da biste ga otvorili

Kliknite desnom tipkom miša Kliknite desnom tipkom miša iznad objekta na
zaslonu da biste prikazali drugi prozor ili  izbornik

Podebljani  tekst
Koristi se za gumb, naziv zaslona, naziv polja ili
mogućnost na izborniku. Na primjer: Patient >
New Patient  (Bolesnik, Novi bolesnik).

NAPOMENA: Pruža dodatne informacije o postupku ili  koraku.

OPREZ:
Upozorava na opasnost koja, ako se ne izbjegne,
može uzrokovati manje ili  umjereno oštećenje
softverskog programa ili  opreme.

UPOZORENJE:
Upozorava na potencijalnu opasnost koja, ako se
ne izbjegne,  može uzrokovati smrt ili  tešku
ozljedu. Može označavati i  mogućnost teških
nuspojava i sigurnosnih rizika.

Sigurnost korisnika

Indikacije za upotrebu

Sustav CareLink Pro koristi se kao alat koji  olakšava život s dijabetesom. Svrha je tog sustava

prikupljanje informacija koje se prenose s inzulinskih pumpi, mjerača glukoze i sustava za

stalno praćenje glukoze te njihovo pretvaranje u izvješća softvera CareLink Pro. Izvješća sadrže

informacije koje se mogu koristiti za identificiranje trendova i praćenje dnevnih aktivnosti –

kao što su unos ugljikohidrata, vremena obroka, davanje inzulina i vrijednosti  glukoze.

Upozorenja

• Sustav trebaju koristiti zdravstveni djelatnici s iskustvom u kontroli dijabetesa.

• Rezultati sustava nisu pouzdan temelj za davanje zdravstvenih savjeta te ih ne bi trebalo tako

koristiti.
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• Ovaj proizvod treba koristiti isključivo s podržanim uređajima navedenima u ovom

dokumentu (pogledajte Podržani uređaji na stranici 2).

• Bolesnicima treba preporučiti da prate svoju razinu glukoze u krvi barem 4 do 6 puta dnevno.

• Bolesnike treba upozoriti da ne mijenjaju svoju terapiju bez savjetovanja sa zdravstvenim

djelatnikom.

• Bolesnike treba upozoriti da odluke o liječenju trebaju donositi na temelju smjernica koje su

dobili od zdravstvenog djelatnika i rezultata mjerača glukoze u krvi, a ne rezultata senzora

glukoze.

Kontraindikacije

Ovaj softver ne treba koristiti s uređajima koji  nisu navedeni u odjeljku Podržani uređaji  na

stranici  2.  Proizvod, uz to, ne treba koristiti za liječenje drugih zdravstvenih poremećaja osim

dijabetesa.

Ako je na vašem računalu trenutno pokrenut neki od sljedećih programa, zatvorite ga prije

otvaranja ovog softvera:

• Softver CGMS® System Solutions™ (7310)

• Softver za pumpe i mjerače Solutions® (7311)

• Softver Guardian® Solutions® (7315)

• ParadigmPAL™ (7330)

• Softver CareLink® Personal (7333)

• Softver Solutions® za CGMS®iPro (7319)
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Uvod u rad

Ovo vas poglavlje vodi kroz pokretanje softvera CareLink Pro, otvaranje i zatvaranje zapisa o

bolesniku te postavljanje preferenci koje se primjenjuju na sve bolesnike u sustavu.

Prije početka

Ako prvi put koristite CareLink Pro, morate provjeriti jeste li  postavili  General preferences

(Opće preference) (pogledajte odjeljak Opće preference na stranici  12).  Te preference

određuju kako se određene stavke prikazuju u softveru i izvješćima te kako želite da sustav

komunicira s internetom.

Preference možete postaviti  u bilo kojem trenutku. Ostale preference možete postaviti i

kasnije, kada se bolje upoznate sa softverom CareLink Pro.

Primarni zadaci sustava

U sljedećoj su tablici prikazani glavni zadaci čije se izvršavanje preporučuje pri prvom

postavljanju i  korištenju programa CareLink Pro. Navodi se i u kojem se dijelu korisničkog

priručnika opisuje koji  zadatak.

Korak Lokacija

Upoznajte se s korisničkim sučeljem programa CareLink
Pro. Kretanje po sustavu na stranici 8

Definirajte globalne sistemske mogućnosti koje će vaša
ambulanta koristiti. Postavljanje preferenci  sustava na stranici  11

Stvorite profile za svakog bolesnika. Dodavanje novih profila na stranici 20

Povežite se s računima bolesnika u sustavu CareLink
Personal.

Povezivanje sa sustavom CareLink Personal na
stranici  21

Dodajte pumpe i mjerače bolesnika u njihove profile. Dodavanje uređaja na stranici  28

Čitajte podatke s pumpe i mjerača bolesnika. Čitanje podataka iz uređaja na stranici  34

Postavite i  generirajte izvješća za svakog bolesnika. Stvaranje izvješća na stranici  37
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Korak Lokacija

Redovito stvarajte sigurnosne kopije baze podataka
programa CareLink Pro.

Stvaranje sigurnosne kopije baze podataka na
stranici  47

Ažurirajte softver CareLink Pro. Primjena ažuriranja softvera na stranici  46

Kretanje po sustavu

Prije početka rada s programom CareLink Pro trebali biste se upoznati s korisničkim sučeljem.

Korisničko se sučelje sastoji od izbornika, alatne trake, navigacijske trake, radnih prostora i

prozora Guide Me (Vodi me).

Otvaranje programa CareLink Pro

1 Dva puta kliknite ikonu CareLink Pro  na radnoj površini računala ili odaberite Medtronic

CareLink Pro  s popisa Programs (Programi) na izborniku Start u operacijskom sustavu

Windows.

Ako vaša ustanova zahtijeva unos lozinke, prikazuje se zaslon za prijavu.

a. Unesite svoju lozinku u polje Password  (Lozinka).

NAPOMENA: traženje lozinke neobavezna je značajka koja se postavlja tijekom

postupka instalacije.

b. Kliknite LOGIN (Prijava).

Prikazat će se početni zaslon.

2 Da biste stvorili zapis o novom bolesniku, kliknite New Patient  (Novi bolesnik). Da biste

otvorili zapis o bolesniku s popisa bolesnika u sustavu, kliknite Open Patient  (Otvori

bolesnika).

Radni prostori

Ako je zapis bolesnika otvoren, možete kliknuti  jedan od gumba na navigacijskoj traci da bi se

prikazao odgovarajući radni prostor. Te radne prostore koristite za unos ili  odabir podataka

radi obavljanja određenih zadataka za tog bolesnika u softveru CareLink Pro.

Profile (Profil):   omogućuje održavanje
pohranjenih podataka o bolesniku, kao što su
ime i datum rođenja. Taj vam radni prostor
ujedno omogućuje povezivanje s
bolesnikovim računom u sustavu CareLink
Personal.

Devices (Uređaji):  omogućuje pohranu
podataka potrebnih za očitavanje
bolesnikovih uređaja.

Reports (Izvješća):   omogućuje odabir
parametara i izvješća koji će se generirati  za
bolesnika.
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Dok ne dodate i ne spremite profil  za nekog bolesnika, za njega je dostupan samo radni

prostor Profile (Profil). Dok za nekog bolesnika ne dodate uređaje, za njega su dostupni samo

radni prostori Profile (Profil)  i  Devices (Uređaji).

Alatna traka

Alatna traka softvera CareLink Pro omogućuje brz pristup često korištenim značajkama. Alatna

traka sadrži sljedeće gumbe:

Gumb Naziv Funkcija

Add Patient (Dodavanje
bolesnika)

Otvara radni prostor Profile
(Profil)  da biste u sustav mogli
dodati zapis o novom
bolesniku.

Open Patient (Otvaranje
bolesnika)

Otvara tablicu Patient Lookup
(Traženje bolesnika) u kojoj
možete izabrati zapis
postojećeg bolesnika koji želite
pogledati.

Guide Me (Vodi me)

Prikazuje ili  sakriva prozor Guide
Me (Vodi me). Kliknite da biste
vidjeli kontekstne savjete
sustava.

Kartice bolesnika

Kada otvorite zapis bolesnika, uz alatnu se traku prikazuje kartica s imenom bolesnika. Ako je

kartica aktivna, to znači da su zapis o bolesniku i  radni prostor aktivni te da za tog bolesnika

možete obavljati zadatke u programu CareLink Pro.

Da biste aktivirali zapis bolesnika i počeli raditi s njim, kliknite na karticu tog bolesnika. Da

biste zatvorili  zapis bolesnika, kliknite gumb Close  (Zatvori)  na kartici.

Značajka Guide Me (Vodi me) 

Značajka Guide Me (Vodi me) dostupna je svuda u programu CareLink Pro. Ona otvara prozor

s kontekstnim savjetima o radnjama koje možete poduzeti  iz dijela sustava koji je trenutno

aktivan. Prozori značajke Guide Me (Vodi me) mogu sadržavati i  veze >> learn more  (saznajte
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više).  Kada ih kliknete, te vas veze vode do relevantnog odjeljka mrežne pomoći u kojem

možete pronaći dodatne informacije. Značajka Guide Me (Vodi me) prema zadanim je

postavkama omogućena. No možete je isključiti u bilo kojem trenutku.

Uključivanje i isključivanje značajke Guide me (Vodi me)

Da biste uključili  ili  isključili  značajku Guide Me (Vodi me), učinite nešto od sljedećeg:

• Kliknite gumb Guide Me  (Vodi me). 

• Odaberite Help  (Pomoć) > Guide Me  (Vodi me).

Otvaranje zapisa o bolesniku

Istodobno može biti otvoreno najviše šest bolesničkih zapisa. Ako još niste stvorili  profile

bolesnika, pogledajte odjeljak Dodavanje novih profila na stranici  20.

1 Odaberite File > New Patient (Datoteka, Novi bolesnik) ili kliknite gumb Open Patient

(Otvaranje bolesnika).  Prikazuje se popis bolesnika sličan sljedećem.
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NAPOMENA: ako primite poruku s napomenom da ste otvorili  previše zapisa o

bolesniku, kliknite OK (U redu), zatvorite zapis i  nastavite.

2 Pronađite bolesnika na popisu tako da upišete njegovo ime ili dio imena u polje Find a

Patient  (Pronađi bolesnika). Kada je bolesnik istaknut na popisu, kliknite OPEN (Otvori),

dvokliknite popis ili pritisnite tipku ENTER. Po popisu se možete kretati i  korištenjem strelica

za gore i dolje na tipkovnici.

Za bolesnika se prikazuje radni prostor Devices  (Uređaji) (ako uređaji još nisu dodani) ili  radni

prostor Reports  (Izvješća).

3 Da biste vidjeli radni prostor Profile (Profil) za bolesnika, kliknite gumb Profile (Profil) 

na navigacijskoj traci.

Zatvaranje zapisa o bolesniku

1 Provjerite je li  zapis bolesnika koji želite zatvoriti aktivan (kartica je istaknuta).

2 Učinite nešto od navedenog:

a. Odaberite File > Close Patient  (Datoteka, Zatvori bolesnika).

b. Kliknite gumb Close  (Zatvori)  na kartici bolesnika.

c. Pritisnite Ctrl+F4.

Postavljanje preferenci sustava

Te se preference primjenjuju na sve bolesnike u sustavu. Informacije o preferencama koje

utječu samo na pojedine bolesnike potražite u odjeljku Provjera postavki izvješća na

stranici  40.

Preference su prikazane u sljedećim grupama:

• General (Općenito)

- Glucose units (Jedinice glukoze)

- Carbohydrate units (Jedinice ugljikohidrata)

- Communications (Komunikacija)

- Otklanjanje poteškoća

• Patient Profile (Profil bolesnika)

- odabir i raspoređivanje polja podataka u profilima bolesnika

• Patient Lookup (Traženje bolesnika)

- modificiranje i promjena redoslijeda polja koja se prikazuju kada odaberete Open Patient

(Otvori bolesnika) da biste prikazali popis bolesnika

• Report Generation (Stvaranje izvještaja)

- odabir polja podataka koja želite da se prikazuju kada odaberete unos u izvješće Daily

Detail (Dnevne pojedinosti) iz podatkovne tablice
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Opće preference

Na kartici  General (Opće postavke) odredite kako će se u programu prikazivati određene

vrste informacija i postavite preference vanjske komunikacije.

1 Ako kartica General  (Opće postavke) još nije aktivna, kliknite je.

2 Odaberite Tools > Options  (Alati, Mogućnosti). Prikazuje se sljedeći prozor.

3 Kliknite gumb mogućnosti da biste odabrali željenu vrijednost.

- Glucose Units (Jedinice glukoze): mg/dL ili  mmol/L

- Carbohydrate Units  (Jedinice ugljikohidrata): grami ili razmjene

a. Ako ste za Carbohydrate Units (Jedinice ugljikohidrata) odabrali Exchanges  (Razmjene),

upišite odgovarajući broj u polje grams are equal to 1 Exchange (grama vrijedi kao 1

razmjena).

4 Kliknite da biste potvrdili ili poništili  okvir u odjeljku Chart Options > Overview Report

(Mogućnosti grafikona > Izvješće o pregledu). Ako je okvir potvrđen, aplikacija će crtama

povezati očitanja glukoze u krvi na grafikonu Meter Glucose Overlay (Slika mjerenja glukoze).

(To je grafikon koji se pojavljuje u izvješću Sensor and Meter Overview Report (Izvješće o

senzoru i pregledu mjerača).)

5 Za sljedeće mogućnosti odjeljka Communications (Komunikacije) klikom potvrdite

(omogućite) ili poništite (onemogućite) potvrdni okvir:

NAPOMENA: obavezno slijedite smjernice svoje ambulante ili IT odjela za postavljanje
komunikacijskih preferenci.

- Automatically check for software updates (Automatsko traženje ažuriranja

programa):  kada je ta mogućnost odabrana, svakom sustavu na kojem je pokrenut

CareLink Pro poslat će se obavijest svaki put kada postane dostupno ažuriranje
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programa. Aktivni će korisnik tada imati mogućnost preuzimanja i instalacije ažuriranja.

Da biste to spriječili  i uveli upravljanu distribuciju ažuriranja programa, možete poništiti

taj potvrdni okvir.

- Synchronize with Medtronic CareLink® Personal (Sinkronizacija s programom

Medtronic CareLink® Personal): Potvrdite taj okvir ako želite da sustav automatski

sinkronizira podatke iz bolesnikova CareLink Personal programa pri svakom otvaranju

profila. Ako poništite taj potvrdni okvir, morat ćete ručno sinkronizirati podatke iz

programa CareLink Personal za svakog bolesnika.

6 Kliknite da biste potvrdili ili poništili  okvir u odjeljku Troubleshooting  (Otklanjanje

poteškoća). Ako je potvrdni okvir odabran, program će spremiti zapis s očitanjima uređaja

radi otklanjanja poteškoća.

7 Kliknite OK (U redu) da biste spremili opće preference.

Preference profila bolesnika

To je globalna postavka koja određuje sadržaj vaših profila.  U radnom prostoru Profiles (Profil)

možete prilagoditi polja da biste uključili  informacije koje su najvažnije za vašu ustanovu.

Možete dodavati ili  uklanjati polja,  stvarati vlastita prilagođena polja i određivati redoslijed

prikazivanja polja u prozoru.

1 Odaberite Tools > Options  (Alati, Mogućnosti).

2 Kliknite karticu Patient Profile  (Profil bolesnika).  Prikazuje se sljedeći prozor.

NAPOMENA: pomoću potvrdnih okvira odaberite polja koja želite uvrstiti  u profil.

Koristite strelice prema gore i  prema dolje da biste poredali polja.

Odabir podatkovnih polja

1 Pomoću potvrdnih okvira dodajte željena polja.
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NAPOMENA: polja First Name (Ime) i  Last Name (Prezime) nije moguće ukloniti.

2 Da biste uklonili polje iz profila, poništite njegov potvrdni okvir.

3 Da biste polje učinili obaveznim, potvrdite okvir u stupcu Required  (Obavezno). Obavezna

se polja moraju ispuniti radi stvaranja profila.

Dodavanje prilagođenog polja

1 Potvrdite okvir s lijeve strane praznog prilagođenog polja.

2 Unesite tekst da biste polju dodijelili naziv (primjerice "Kontakt u hitnom slučaju"). Taj će

naziv polja biti prikazan na profilu bolesnika.

3 Da biste polje učinili obaveznim, potvrdite okvir u stupcu Required  (Obavezno).

NAPOMENA: da biste prilagođeno polje uklonili  iz profila, poništite potvrdni okvir

pokraj polja koje želite ukloniti.

Promjena redoslijeda podatkovnih polja

Odaberite polje koje želite premjestiti, a zatim kliknite strelicu prema gore ili  dolje  da

biste ga premjestili  (strelicama prikazanima pri vrhu i pri dnu možete pomaknuti polje

potpuno na vrh ili  na dno popisa).

Zatvaranje preferenci profila bolesnika

Kada popis Field Order (Redoslijed polja) sadrži  sva željena polja poredana ispravnim

redoslijedom, kliknite OK  (U redu).

Profili  bolesnika sada sadrže polja i redoslijed polja koji  ste upravo odabrali.

Preference traženja bolesnika

Tablica Patient Lookup (Traženje bolesnika) koristi se za traženje i otvaranje zapisa o bolesniku.

Tablica sadrži sve bolesnike u bazi podataka i pruža informacije za identifikaciju iz profila

bolesnika. Možete prilagoditi informacije iz tablice i redoslijed prikazivanja stupaca. Da biste

prilagodili tablicu Patient Lookup (Traženje bolesnika), učinite sljedeće:

1 Odaberite Tools > Options  (Alati, Mogućnosti).
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2 Kliknite karticu Patient Lookup (Traženje bolesnika). Prikazuje se sljedeći prozor.

NAPOMENA: pomoću potvrdnih okvira odaberite polja koja želite uvrstiti  u tablicu

Patient Lookup (Traženje bolesnika).  Koristite strelice prema gore i  dolje da biste

poredali  stupce.

Odabir podataka za prikaz

Pomoću potvrdnih okvira odaberite vrstu podataka koju želite ili  očistite podatke koje ne

želite prikazati u tablici Patient Lookup (Traženje bolesnika).

Promjena redoslijeda stupaca

Da biste promijenili redoslijed stupaca u tablici Patient Lookup (Traženje bolesnika), odaberite

stupac koji ćete pomaknuti i  kliknite strelice prema gore ili  dolje  (strelicama prikazanima

pri vrhu i  pri  dnu možete pomaknuti podatkovni stupac potpuno na vrh ili  na dno popisa).

podatkovni stupac pri vrhu popisa Column Display Order (Redoslijed prikaza stupaca) bit  će

prikazan u prvom stupcu tablice Patient Lookup (Traženje bolesnika).  Podatkovni stupac pri

dnu bit će prikazan u zadnjem stupcu tablice.

Zatvaranje preferenci traženja bolesnika

Kada popis Column Display Order (Redoslijed prikaza stupaca) sadrži  sve željene podatke

ispravnim redoslijedom, kliknite OK  (U redu).

Tablica Patient Lookup (Traženje bolesnika) sada sadrži podatke i redoslijed stupaca koji ste

upravo odabrali.
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Preference generiranja izvješća

Data Table (Tablica s podacima) prikazuje se u prozoru Select and Generate Reports (Odabir

i generiranje izvješća).  Ta se tablica koristi tijekom izvješćivanja. Ona sadrži dnevne

informacije iz uređaja vaših bolesnika i,  ako je to primjenjivo, njihovih računa u sustavu

CareLink Personal. Prema podacima iz tablice lakše ćete odrediti  na koje je dane obvezno

generiranje izvješća Daily Detail  report (Dnevne pojedinosti).  Oni će vam olakšati i

odlučivanje o drugim izvješćima koja trebate generirati.

Ustanova može prilagoditi  podatke koji će se prikazivati u toj tablici,  uključujući i  redoslijed

prikazivanja, ovisno o važnosti za vašu praksu.

NAPOMENA: da biste vidjeli kako se te preference primjenjuju na tablicu s podacima

tijekom stvaranja izvješća, pogledajte odjeljak Odabir vrsta izvješća i  datuma uvrštavanja na

stranici  42.

1 Odaberite Tools > Options  (Alati, Mogućnosti).

2 Kliknite karticu Report Generation (Generiranje izvješća). Prikazuje se sljedeći prozor.

Odabir podataka za prikaz

Pomoću potvrdnih okvira odaberite vrstu podataka koje želite ili  očistite podatke koje ne

želite prikazati u podatkovnoj tablici.

U tablicu Data Table (Tablica s podacima) možete uvrstiti sljedeće informacije.
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Naziv stupca Definicija

№ of Meter Readings (Broj očitanja na mjeračima) Broj očitanja za određeni datum zabilježenih
aktivnim uređajima.

Meter Readings Average (Prosjek očitanja na
mjeračima)

Prosjek očitanja glukoze zabilježenih na aktivnim
uređajima.

Sensor Duration (Trajanje senzora)
Vrijeme unutar određenog datuma za koje su
zabilježeni podaci  senzora. Vrijednosti su -- (ništa),
0:05 - 24:00.

Sensor Average (Prosjek senzora) Prosjek očitanja senzora zabilježenih na određeni
datum.

Highest Reading (Najviše očitanje) Najviša očitana vrijednost glukoze (sa senzora ili
mjerača) za određeni datum.

Lowest Reading (Najniže očitanje) Najniža očitana vrijednost glukoze (sa senzora ili
mjerača) za određeni datum.

Avg AUC Below Target (Prosječno područje ispod
krivulje za ciljnu razinu bolesnika)

Prosječno područje ispod krivulje za ciljnu razinu
bolesnika.

Avg AUC Above Target (Prosječno područje iznad
krivulje za ciljnu razinu bolesnika)

Prosječno područje iznad krivulje za ciljnu razinu
bolesnika.

Total Carbs (Ukupni ugljikohidrati)

Zbroj svih ugljikohidrata (zaokružen na najbliži gram
ili razmjenu od 0,1, ovisno o mjernoj jedinici) koja je
zabilježena tijekom dana pomoću Bolus Wizard
događaja ili  markera ugljikohidrata na pumpi ili
Guardian monitoru.

Suspend Duration (Trajanje prekida) Vrijeme prekida rada pumpe na određeni datum.
Vrijednosti su -- (ništa), 0:01 - 24:00.

№ of Rewinds (Broj okretanja) Broj okretanja za određeni datum.

№ of Primes (or Fills) (Broj početnih ciklusa ili
punjenja)

Broj početnih ciklusa (ili  punjenja) zabilježenih za
određeni datum.

Prime (or Fill) Volume (U) (Količina početnih ciklusa ili
punjenja)

Ukupna količina inzulina koja se koristi za početni
ciklus (ili  punjenje) na određeni datum.

Total Insulin (U) (Ukupni inzulin) Ukupna količina inzulina ubrizgana tijekom
određenog datuma i zabilježena u pumpi.

Total Basal  (U) (Ukupni bazalni)
Ukupna količina bazalnog inzulina ubrizganog
tijekom određenog datuma (ukupni ubrizgani inzulin
minus zbroj svih ubrizganih bolusa).

Total Bolus (U) (Ukupni bolus) Ukupna količina inzulina ubrizgana u bolusima
tijekom određenog datuma i zabilježena u pumpi.

Basal  % (Postotak bazalnog inzulina)
Pokazuje omjer (u cjelobrojnim postotnim
vrijednostima) bazalnog inzulina u odnosu na
ukupni inzulin.

Bolus % (Postotak bolusa)
Pokazuje omjer (u cjelobrojnim postotnim
vrijednostima) inzulina u bolusima u odnosu na
ukupni inzulin.

№ of Boluses (Broj bolusa) Broj bolusa zabilježenih na određeni datum.

Bolus Wizard Events (Bolus Wizard događaji) Broj Bolus Wizard događaja zabilježenih na određeni
datum.

Bolus Wizard Overrides (Preskakanje Bolus Wizard
događaja)

Broj Bolus Wizard događaja kod kojih se ubrizgani
inzulin razlikuje od preporučene količine.

№ of Meal Boluses (Broj bolusa za obroke)
Broj Bolus Wizard događaja s količinama
ugljikohidrata većim od nule zabilježenih na
određeni datum.
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Naziv stupca Definicija

№ of Correction Boluses (Broj korektivnih bolusa) Broj Bolus Wizard događaja s količinama korekcije
većim od nule zabilježenih na određeni datum.

№ of Manual Boluses (Broj ručnih bolusa) Broj bolusa zabilježenih tijekom određenog datuma
koji  nisu bili  Bolus Wizard događaji.

Promjena redoslijeda stupaca

Da biste promijenili redoslijed stupaca u tablici Data Table (Tablica s podacima), odaberite

stupac koji ćete pomaknuti  i  kliknite strelice gore ili  dolje  (strelicama prikazanima pri

vrhu i pri  dnu možete pomaknuti podatkovni stupac potpuno na vrh ili  na dno popisa).

NAPOMENA: podatkovni stupac na vrhu popisa Column Order (Redoslijed stupaca) bit će
prikazan u prvom stupcu podatkovne tablice.  Stavke pri dnu bit će prikazane u zadnjem

stupcu podatkovne tablice.

Dovršenje preferenci generiranja izvješća

Kada popis Column Order (Redoslijed stupaca) sadrži sve željene podatke ispravnim

redoslijedom, kliknite OK  (U redu).

Podatkovna tablica sada sadrži podatke i redoslijed stupaca koji ste upravo odabrali.
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Radni prostor Profile (Profil)

Profil je nešto poput početne stranice medicinskog kartona. On sadrži podatke o bolesniku,

kao što je ime i  datum rođenja. Profil  je potreban za prikupljanje podataka iz uređaja i

korištenje u izvješćima o terapiji.

Radni prostor Profile (Profil)  ujedno omogućuje povezivanje s bolesnikovim računom u

programu CareLink Personal.  Nakon uspostave veze u bilo kojem trenutku možete dohvatiti

podatke o bolesniku pohranjene u sustavu CareLink Personal, a bolesnik ne mora biti prisutan.

Prije početka

Možda poželite prilagoditi profile bolesnika da bi sadržavali samo onu vrstu podataka koju

želite prikupiti.  Dodatne informacije potražite u odjeljku Preference profila bolesnika na

stranici  13.

CareLink Pro Korisnički priručnik   Radni prostor Profile (Profil) 19



Potrebno je i  korisničko ime i lozinka da biste postavili  vezu s bolesnikovim računom u

sustavu CareLink Personal.  Bolesnik mora biti prisutan da bi vam pružio te podatke.

Dodavanje novih profila

Svaki put kada dodate bolesnika u sustav CareLink Pro, najprije morate ispuniti profil.

1 Odaberite File > New Patient (Datoteka, Novi bolesnik) ili kliknite gumb Add Patient  (Dodaj

bolesnika). 

Prikazuje se radni prostor Profile (Profil).

NAPOMENA: da biste dodali ili  promijenili  polja u profilu bolesnika, kliknite Customize

fields (Prilagodi polja).  Pogledajte odjeljak Preference profila bolesnika na stranici 13.

2 Ispunite polja u odjeljku Patient Profile  (Profil bolesnika).

3 Kliknite SAVE  (Spremi).

Profil novog bolesnika dodaje se u bazu podataka sustava CareLink Pro. Prikazuje se poruka

kojom se potvrđuje da je profil spremljen.

Ispunjavanje obaveznih polja

1 Ako obavezno polje nije ispunjeno kada spremate profil bolesnika, pokraj tog polja prikazuje

se poruka. Spremanje profila neće vam biti dopušteno sve dok ne izvršite unos u polje.

2 Ispunite polje.

3 Kliknite SAVE  (Spremi).

4 Kada se pojavi poruka za potvrdu, kliknite OK (U redu).

Uređivanje profila bolesnika

1 Provjerite je li  radni prostor Profile (Profil) bolesnika otvoren.

2 Kliknite EDIT  (Uređivanje).

3 Uredite podatke u odjeljku Patient Profile (Profil bolesnika).

4 Kliknite SAVE  (Spremi).

Prikazuje se poruka kojom se potvrđuje da je profil spremljen.

Brisanje podataka o bolesniku iz sustava

1 Provjerite je li  radni prostor Profile (Profil) bolesnika otvoren.

2 Provjerite je li  riječ o bolesniku kojeg želite izbrisati. Brisanjem profila bolesnika ujedno ćete

ukloniti sve njegove podatke iz baze podataka sustava CareLink Pro. Taj postupak nije

moguće poništiti.
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3 Kliknite >> delete patient record (izbriši zapis o bolesniku) iznad odjeljka za sinkronizaciju

profila.

Prikazuje se poruka s upozorenjem da će se brisanjem zapisa izbrisati svi podaci o bolesniku.

4 Kliknite Yes  (Da) da biste izbrisali zapis o bolesniku.

Povezivanje sa sustavom CareLink Personal

Ako je bolesnik suglasan, možete postaviti vezu s njegovim računom u sustavu CareLink

Personal.  Taj  web-alat bolesnicima omogućuje prijenos i pohranu podataka primljenih iz

uređaja te sastavljanje različitih izvješća o terapiji.

Kada se povežete s bolesnikovim računom u sustavu CareLink Personal,  možete dohvatiti

podatke iz uređaja koji  su tamo pohranjeni.  To je idealno za stvaranje izvješća sustava

CareLink Pro o terapiji  između posjeta ordinaciji. Uz to se i smanjuje potreba za čitanjem

bolesnikova uređaja u ordinaciji.

Ako bolesnik još nema račun u sustavu CareLink Personal, možete mu poslati poruku e-pošte i

pozvati  ga da otvori račun.

Povezivanje s postojećim računom

NAPOMENA: bolesnik mora biti prisutan radi dovršenja ovih koraka.

1 Morate biti povezani s internetom.

2 Otvorite radni prostor Profile (Profil) za bolesnika.

3 Ispunite sva obavezna polja u odjeljku Patient Profile (Profil bolesnika).

4 Kliknite LINK TO EXISTING ACCOUNT  (Povezivanje s postojećim računom).

Prikazat će se zaslon za prijavu u sustav CareLink Personal.

5 Bolesnik sada mora:

a. upisati svoje korisničko ime i lozinku

b. kliknuti Sign In  (Prijava)

Prikazuje se stranica Grant Access  (Dopuštanje pristupa) na temelju postavki prijave

bolesnika za jezik i regiju.

6 Bolesnik sada mora:

a. pročitati odjeljak Terms of Use (Uvjeti upotrebe)

b. klikom potvrditi okvir pored teksta I agree to the Terms of Use above... (Slažem se s

gore navedenim uvjetima upotrebe)

c. kliknuti Grant Access (Dopusti pristup)

d. obavijestiti vas kada se pojavi stranica Thank You (Zahvala).

7 Po potrebi možete ispisati uvjete upotrebe za bolesnika klikom na gumb Print (Ispis). Sada

ste povezani s bolesnikovim računom u sustavu CareLink Personal.
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Slanje pozivnice e-poštom

Da biste bolesniku poslali e-poštu s pozivnicom za otvaranje računa za CareLink Personal,

učinite sljedeće:

1 Otvorite radni prostor Profile (Profil) za bolesnika.

2 Ispunite sva obavezna polja u odjeljku Patient Profile (Profil bolesnika).

3 Kliknite SEND E-MAIL INVITATION TO PATIENT  (Pošalji  bolesniku pozivnicu e-poštom).

4 Provjerite jesu li  polja Patient Name (Ime bolesnika), Email Addresss (Adresa e-pošte) i

Language (Jezik) ispravno ispunjena.

5 Kliknite SEND  (Pošalji).

U području sa statusom profila bolesnika potvrđuje se slanje e-pošte.

Primanje podataka iz povezanog računa

Ako ste povezani s bolesnikovim računom u sustavu CareLink Personal,  svi novi podaci iz

računa automatski se šalju svaki put kada otvorite profil bolesnika u programu CareLink

Pro.

NAPOMENA: da biste osigurali taj proces, idite na Tools > Options > General (Alati,
Mogućnosti, Općenito) i  provjerite je li  potvrđen okvir "Synchronize with CareLink

Personal" (Sinkronizacija sa softverom CareLink Personal).

Slijedite ove korake da biste preuzeli bolesnikove podatke iz sustava CareLink Personal u bilo

kojem trenutku nakon otvaranja profila bolesnika:

1 Provjerite je li  otvoren radni prostor Profile  za bolesnika te jeste li  povezani s internetom.

2 Odaberite Tools > Synchronize Patient Data (Alati, Sinkronizacija podataka o bolesniku).

Ikona za sinkronizaciju  na kartici bolesnika počinje se okretati. Kada se ikona zaustavi,

postupak je dovršen.
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NAPOMENA: ako bolesnik ne želi više dijeliti  svoje podatke iz sustava CareLink

Personal,  prikazuje se odgovarajuća poruka.

3 Svi dodatni podaci dohvaćeni iz sustava CareLink Personal bit će vidljivi u izvješćima o

bolesniku.

Prekid veze bolesnikova računa u sustavu CareLink Personal sa softverom
CareLink Pro

Možete prekinuti vezu bolesnikova računa u sustavu CareLink Personal sa softverom CareLink

Pro. Ta je mogućnost dostupna tek nakon uspostavljanja veze. Nakon prekida veze CareLink Pro

više ne može dohvaćati bolesnikove podatke iz sustava CareLink Personal. To ne utječe na

osobnu upotrebu računa u sustavu CareLink Personal od strane bolesnika.

1 Otvorite zapis o bolesniku i pristupite radnom prostoru Profile (Profil).

2 Kliknite UNLINK ACCOUNT (Prekini vezu s računom).

3 Kliknite Yes (Da) u poruci za potvrdu. Osobni profil bolesnika više nije povezan s programom

CareLink Pro.

Status se mijenja u Not linked (Nije povezan), a prikazuju se gumbi LINK TO EXISTING

ACCOUNT  (Povezivanje s postojećim računom) i SEND E-MAIL INVITATION TO PATIENT

(Pošalji bolesniku pozivnicu e-poštom).

CareLink Pro Korisnički priručnik   Radni prostor Profile (Profil) 23



4

Postavljanje hardvera

Da biste podatke očitavali izravno s uređaja, morate imati bolesnikov uređaj kod sebe, kao i

kabele ili  druge komunikacijske uređaje potrebne za slanje podataka na računalo.

Ako je bolesnik prenio podatke iz svojeg uređaja u svoj račun u sustavu CareLink Personal,

umjesto toga možete dohvatiti podatke povezivanjem s njegovim računom. Informacije o

povezivanju s bolesnikovim računom u sustavu CareLink Personal potražite u odjeljku

Povezivanje sa sustavom CareLink Personal na stranici  21.

Povezivanje uređaja

Proučite pregledni dijagram da biste stekli  ideju o tome kako postaviti uređaje radi

komunikacije s računalom. Dijagrami koji slijede ilustriraju posebne aspekte komunikacije

uređaja.

Dodatne pojedinosti možete pronaći u uputama koje CareLink Pro prikazuje dok očitavate

uređaje.
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Pregled postavljanja hardvera

Ovaj primjer prikazuje kako se CareLink USB koristi za komunikaciju između pumpe i  računala:

Primjeri povezivanja serijskog i USB kabela:
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Dodatni ComLink za korištenje s pumpom serije Paradigm:

Dodatna stanica Com-Station za korištenje s pumpom Medtronic MiniMed 508:
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Radni prostor Devices (Uređaji)

Informacije koje ćete trebati za očitavanje podataka s bolesnikova uređaja, primjerice marka,

model i serijski broj,  pohranjene su u radnom prostoru Devices (Uređaji). Zato ih ne morate

navoditi prilikom svakog čitanja podataka s uređaja.

Uređaji  u radnom prostoru Devices (Uređaji)  pohranjeni su na jednom od dva popisa: Active

Devices (Aktivni uređaji)  ili  Inactive Devices (Neaktivni uređaji).  Kada dodate uređaj,  on se

automatski smješta na popis Active Devices (Aktivni uređaji).  Možete čitati samo podatke s

uređaja prikazanih na popisu Active Devices (Aktivni uređaji).  Na tom će se popisu vjerojatno

nalaziti uređaji koje bolesnik trenutno koristi.

Ostali uređaji  koji pripadaju bolesniku, no trenutno se ne koriste, mogu se pohraniti na popisu

Inactive Devices (Neaktivni uređaji).  Na taj način podaci ostaju zapisani.  Te je uređaje moguće

učiniti aktivnima u bilo kojem trenutku.
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Prije početka

Da biste mogli otvoriti radni prostor Devices (Uređaji)  za nekog bolesnika, njegov profil  mora

biti spremljen u sustavu. Pogledajte odjeljak Dodavanje novih profila na stranici  20.

Da biste dodali uređaj ili  pročitali  podatke izravno s njega, uređaj mora uspostaviti

komunikaciju s računalom. Pogledajte Povezivanje uređaja na stranici  24  da biste doznali  kako

postaviti uređaje radi komunikacije s računalom.

Dodavanje uređaja

Podatke s bolesnikova računa u sustavu CareLink Personal možete dohvatiti i  ako uređaj još

nije dodan u sustav. Ti se uređaji  automatski dodaju nakon sinkronizacije podataka između

sustava CareLink Personal i  CareLink Pro.

NAPOMENA: može postojati samo jedna aktivna pumpa za jednog bolesnika. Dodavanjem
nove pumpe postojeću ćete pomaknuti na popis neaktivnih.

Dodavanje pumpe Medtronic ili monitora Guardian

1 Provjerite je li  uređaj koji dodajete postavljen za komunikaciju s računalom (Povezivanje

uređaja na stranici 24 sadrži opis koraka povezivanja).

2 Kliknite karticu bolesnika ili dva puta kliknite ime bolesnika na tablici Patient Lookup

(Traženje bolesnika).

3 Kliknite Devices  (Uređaji)   da biste pristupili radnom prostoru Devices (Uređaji) za

bolesnika.

4 Kliknite ADD DEVICE  (Dodaj uređaj).

5 Odaberite Medtronic Pump/Guardian.  Prikazuje se čarobnjak Add Medtronic Pump/

Guardian  (Dodavanje pumpe Medtronic/Guardian).
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NAPOMENA: model pumpe naveden je na stražnjoj  strani pumpe ili  na zaslonu statusa

pumpe.

6 Odaberite gumb mogućnosti da biste odredili koji uređaj dodajete.

Ako ste odabrali mogućnost MiniMed 508 pump,  idite na 9. korak.

7 Kliknite NEXT (Dalje).  Prikazuje se stranica Serial Number (Serijski broj).

NAPOMENA: ako ne unesete ispravan serijski  broj, prikazuje se poruka o pogrešci.

Pogledajte primjere na ovoj stranici i  provjerite unosite li  ispravne znakove sa
stražnje strane pumpe. Prema potrebi ponovno unesite šest znakova.

8 Primjeri na ovoj stranici olakšat će vam pronalaženje šesteroznamenkastog broja na uređaju

koji dodajete. (Ako vam je potrebna dodatna pomoć da ga pronađete, kliknite >> learn more

(doznajte više)). Upišite šest znakova u polje Device Serial Number (Serijski broj uređaja).

9 Kliknite NEXT (Dalje).  Prikazuje se stranica Communication Options  (Mogućnosti

komunikacije) koja izgleda poput sljedeće.
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10 Kliknite padajući izbornik Choose Port  (Odabir priključka) i odaberite priključak s kojim se

ComLink, Paradigm Link®, CareLink USB ili Com-Station povezuje na vašem računalu. Ako

niste sigurni koji priključak odabrati, odaberite Auto Detect (or USB)  (Automatsko otkrivanje

(ili USB)).

11 Kliknite NEXT (Dalje).  Prikazuje se stranica Test Connection (Testiranje veze) koja izgleda

poput sljedeće.

12 Slijedite upute uređaja i kliknite TEST  (Testiraj).

Prikazuje se poruka o tome je li povezivanje bilo uspješno. Ako jest, prijeđite na sljedeći

korak.

NAPOMENA: tim se testom ne čitaju podaci iz pumpe, već se provjerava ispravnost
komunikacije između pumpe i računala.

Ako komunikacija nije ispravna, provjerite je li  hardver između uređaja i računala ispravno

povezan. Također kliknite BACK (Natrag) na stranicama čarobnjaka da biste provjerili jeste li

unijeli ispravne podatke s uređaja.

13 Kliknite DONE  (Dovršeno).

Mjerač se dodaje na bolesnikov popis Active Devices (Aktivni uređaji).

Dodavanje mjerača

1 Kliknite karticu bolesnika ili dva puta kliknite ime bolesnika na tablici Patient Lookup

(Traženje bolesnika).

2 Provjerite komunicira li  mjerač koji dodajete s računalom (Povezivanje uređaja na stranici 24

sadrži opis koraka povezivanja).

3 Kliknite Devices  (Uređaji) da biste pristupili radnom prostoru Devices (Uređaji) za bolesnika.

4 Kliknite gumb ADD DEVICE  (Dodavanje uređaja).
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5 Odaberite Blood Glucose Meter  (Mjerač glukoze u krvi). Prikazuje se čarobnjak Add Blood

Glucose Meter (Dodavanje mjerača glukoze u krvi).

6 Kliknite gumb mogućnosti da biste odabrali ispravnu marku mjerača.

7 Kliknite NEXT (Dalje).  Prikazuje se stranica Meter Model (Model mjerača) (ova se stranica

razlikuje ovisno o proizvođaču mjerača).

8 Kliknite model mjerača koji dodajete da biste ga odabrali.
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9 Kliknite NEXT (Dalje).  Prikazuje se stranica Communication Options  (Mogućnosti

komunikacije).

NAPOMENA: za odabir su dostupne samo valjane mogućnosti za mjerač koji

dodajete.

10 Kliknite padajući izbornik Choose Port  (Odabir priključka) i odaberite priključak s kojim se

ComLink, Paradigm Link ili  CareLink USB povezuje na vašem računalu. Ako niste sigurni koji

priključak odabrati, odaberite Auto Detect (or USB)  (Automatsko otkrivanje (ili  USB)).

11 Kliknite NEXT (Dalje).  Prikazuje se stranica Test Connection (Testiranje veze).

12 Slijedite upute dane za mjerač i kliknite TEST  (Testiraj).

Prikazuje se poruka o tome je li povezivanje bilo uspješno. Ako jest, prijeđite na sljedeći

korak.
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Ako komunikacija nije ispravna, provjerite je li  hardver između uređaja i računala ispravno

povezan. Također kliknite BACK  (Natrag) na čarobnjaku da biste provjerili  jesu li  podaci koje

ste unijeli ispravni.

13 Kliknite DONE  (Dovršeno).

Mjerač se dodaje na bolesnikov popis Active Devices (Aktivni uređaji).

Aktivacija i deaktivacija uređaja

Bolesnikovi se uređaji  mogu prema potrebi premještati s popisa Active Devices (Aktivni

uređaji) na popis Inactive Devices (Neaktivni uređaji)  i  obrnuto. Uređaj mora biti aktivan da

biste s njega mogli pročitati  podatke.

Možete imati neograničen broj mjerača na popisu Active Devices (Aktivni uređaji),  no samo

jednu pumpu. Provjerite želite li  deaktivirati trenutno aktivnu pumpu prije no što dodate

novu.

Deaktivacija uređaja

1 Kliknite karticu bolesnika ili dva puta kliknite ime bolesnika na tablici Patient Lookup

(Traženje bolesnika).

2 Kliknite Devices  (Uređaji) da biste pristupili radnom prostoru Devices (Uređaji) za bolesnika.

Uređaji mogu biti navedeni pod ekvivalentnim nazivom uređaja. Pogledajte odjeljak Podržani

uređaji na stranici 2.

3 Kliknite >> make this device inactive  (deaktiviraj taj uređaj) ispod uređaja koji želite

deaktivirati. Uređaj se premješta na popis Inactive Devices  (Neaktivni uređaji).

Ponovna aktivacija uređaja

1 Kliknite karticu bolesnika ili dva puta kliknite ime bolesnika na tablici Patient Lookup

(Traženje bolesnika).

2 Kliknite gumb Devices (Uređaji). Prikazuje se radni prostor Devices  (Uređaji) za bolesnika.

Uređaji mogu biti navedeni pod ekvivalentnim nazivom uređaja. Pogledajte odjeljak Podržani

uređaji na stranici 2.

3 Kliknite >> activate this device (aktiviraj taj uređaj) ispod uređaja koji želite aktivirati.

Uređaj se premješta na popis Active Devices (Aktivni uređaji).

Brisanje uređaja

Slijedeći ove korake izbrisat ćete uređaj i njegove podatke iz radnog prostora Devices (Uređaji) i

sustava CareLink Pro:

1 Kliknite karticu bolesnika ili dva puta kliknite ime bolesnika na tablici Patient Lookup

(Traženje bolesnika).

2 Kliknite Devices  (Uređaji)  da biste pristupili radnom prostoru Devices  (Uređaji) bolesnika.
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Uređaji mogu biti navedeni pod ekvivalentnim nazivom uređaja. Pogledajte odjeljak Podržani

uređaji na stranici 2.

3 Provjerite nalazi li se uređaj na popisu Inactive Devices  (Neaktivni uređaji). Ako to nije slučaj,

kliknite >> Inactivate this device (Deaktiviraj taj uređaj) pod trenutnim unosom.

4 Kliknite >> delete this device (izbriši taj uređaj) ispod uređaja koji želite izbrisati. Prikazuje se

poruka s upozorenjem da će uređaj i  svi podaci iz njega biti uklonjeni iz zapisa o bolesniku.

5 Kliknite YES (Da) da biste izbrisali uređaj.

Uređaj i njegovi podaci uklanjaju se iz radnog prostora Devices (Uređaji) i iz programa

CareLink Pro. Podaci iz tog uređaja više nisu dostupni za korištenje u izvješćima.

Čitanje podataka iz uređaja

Podatke iz uređaja možete dobiti povezivanjem s postojećim bolesnikovim računom u sustavu

CareLink Personal (pogledajte odjeljak Povezivanje sa sustavom CareLink Personal na

stranici  21).  Druga je mogućnost da podatke pročitate izravno s uređaja, kao što je opisano u

ovom poglavlju.

CareLink Pro može pročitati podatke iz uređaja bolesnika ako se uređaj nalazi na popisu Active

Devices (Aktivni uređaji)  i  komunicira s računalom. Nakon primanja podataka možete ih

koristiti za stvaranje izvješća koja olakšavaju procjenu održavanja terapije bolesnika. Kratak

opis dostupnih izvješća možete pronaći u odjeljku O izvješćima na stranici 43.

Iz pumpe za inzulin CareLink Pro može prikupljati sljedeće podatke:

• različite postavke pumpe, kao što su način rada za upozorenje, glasnoća zvučnog signala i

prikaz vremena

• isporučene količine bazalnog inzulina

• događaji i  isporučene količine u bolusu

• unose u čarobnjaku za bolus

• iznose početnih ciklusa

• razdoblja prekida

• očitanja senzora za glukozu tijekom vremenskog razdoblja kod pumpi sa senzorima

Sustav može prikupiti  podatke i  iz sustava Guardian REAL-Time, uključujući:

• očitanja senzora za glukozu (SG)

• koeficijentne vrijednosti senzora

• kalibracijske čimbenike senzora

• markere obroka

• ubrizgavanja inzulina

U sustav je moguće prenijeti i  razne informacije pohranjene u mjeraču glukoze u krvi  tijekom

očitavanja s uređaja.
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UPOZORENJE: otkažite ili  dovršite privremene bazalne ili  aktivne boluse i  poništite

eventualno aktivne alarme. Pumpa će se zaustaviti radi očitavanja. Po dovršetku

očitavanja provjerite je li  pumpa nastavila s radom.

OPREZ: nemojte koristiti  daljinski  upravljač za pumpu tijekom očitavanja. Ako je baterija

pumpe slaba, pumpa neće poslati podatke na računalo. Zamijenite bateriju ako status

baterije upozorava da je slaba.

1 Kliknite karticu bolesnika ili dva puta kliknite ime bolesnika na tablici Patient Lookup

(Traženje bolesnika)

2 Provjerite komunicira li  bolesnikov uređaj s računalom (pogledajte Povezivanje uređaja na

stranici 24).

3 Kliknite Devices  (Uređaji)  da biste pristupili radnom prostoru Devices  (Uređaji) bolesnika.

Uređaji mogu biti navedeni pod ekvivalentnim nazivom uređaja. Pogledajte odjeljak Podržani

uređaji na stranici 2.

4 Na popisu Active Devices  (Aktivni uređaji) pronađite uređaj s kojeg želite dohvatiti podatke i

provjerite jesu li  podaci u polju Choose port (Odabir priključka) točni.

Za pumpe kliknite padajući izbornik Amount of Data (Količina podataka) i  odaberite koliko

podataka iz pumpe želite da CareLink Pro pročita.

5 Kliknite pridruženi gumb READ DEVICE  (Čitanje uređaja).

6 Slijedite upute karakteristične za uređaj i kliknite OK  (U redu).

7 CareLink Pro prikazuje traku napretka koja se ažurira i prikazuje koliki je postotak podataka s

uređaja pročitan.

Ako kliknete CANCEL  (Odustani) tijekom čitanja uređaja, prikazuje se poruka s upozorenjem

da odustajanje od čitanja uređaja može dovesti do gubitka svih dotad pročitanih podataka.

Da biste ponovno pokrenuli prenošenje, morate kliknuti gumb READ DEVICE (Čitanje

uređaja).

- Da biste odustali, kliknite YES (Da).

- Da biste nastavili čitati podatke s uređaja, kliknite NO  (Ne).

Kada sustav završi čitanje podataka s uređaja, vidjet ćete poruku kojom se potvrđuje da je

čitanje s uređaja dovršeno.

8 Kliknite OK (U redu).

- Za pumpe slijedite upute za nastavak rada.

Ako CareLink Pro ne može dohvatiti podatke iz uređaja, upute potražite u odjeljku o

otklanjanju poteškoća.
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6

Radni prostor Reports (Izvješća)

CareLink Pro nudi različita izvješća koja vam mogu olakšati praćenje terapije za dijabetes.

Informacije u tim izvješćima temelje se na podacima iz bolesnikovih uređaja i njihovih računa

u sustavu CareLink Personal.

Izvješća se mogu generirati na zaslonu, poslati izravno pisaču ili  spremiti kao TIFF ili  PDF

datoteke koje možete priložiti izvješću EMR (Electronic Medical Record – elektronički

medicinski zapis).  Jednim postupkom možete generirati nekoliko vrsta izvješća.

Podaci prikazani u tim izvješćima bilježe se s uređaja bolesnika, s njihovog računa u sustavu

CareLink Personal ili  oboje.

NAPOMENA: u referentnom vodiču za izvješća navedene su dodatne pojedinosti o

komponentama izvješća, kao i uzorci izvješća. Dokumentu Report Reference Guide
(Referentni vodič za izvješća) možete pristupiti iz programa CareLink Pro odabirom

mogućnosti Help > View Report Reference Guide (PDF) (Pomoć > Pregled referentnog

vodiča za izvješća) i  odgovarajućeg jezika.
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Prije početka

Ako želite da neko vremensko razdoblje bude vidljivo u izvješću, morate imati podatke s

uređaja bolesnika za to vremensko razdoblje. Možda ćete bolesnikov uređaj morati povezati s

računalom da biste prije pokretanja izvješća dobili aktualne podatke.

Prije pokretanja izvješća obavezno pažljivo proučite korak Verify Report Settings  (Provjera

postavki izvješća).  Na tom mjestu možete precizno ugoditi izvješće da bi odražavalo podatke o

bolesniku koje želite.

Stvaranje izvješća

U sljedećim odjeljcima pronaći ćete informacije uz koje ćete lakše razumjeti dostupna izvješća

i postupak njihova generiranja.

Ako već poznajete postupak izvješćivanja i znate koja biste izvješća željeli  generirati,  možete

početi.

Otvaranje radnog prostora Reports (Izvješća)

Kliknite karticu bolesnika ili  gumb Open Patient  (Otvori bolesnika)  pa dvokliknite

njegovo ime.

Prikazuje se radni prostor Reports  (Izvješća).

NAPOMENA: da biste provjerili  imate li  najnovije podatke s uređaja iz bolesnikova računa

u sustavu CareLink Personal, kliknite SYNC DATA (Sinkroniziraj podatke).

Odabir razdoblja izvješćivanja

1 Da biste promijenili vremensko razdoblje obuhvaćeno izvješćem, kliknite padajući izbornik

Duration  (Trajanje) i odaberite vrijeme (maksimalno je trajanje 12 tjedana).

2 Datumi početka i kraja automatski se postavljaju, osim ako ne odaberete mogućnost custom

date range (prilagođeni raspon datuma).

NAPOMENA: ako odaberete raspon datuma koji je veći od dopuštenog, prikazuje se

poruka o pogrešci.  Prilagodite trajanje ili  datume.

Ako želite prilagođeni raspon datuma, kliknite padajuće izbornike From (Od) ili  Through  (Do)

i odaberite željeni mjesec, datum ili  godinu.

Kalendar s podacima

U području podatkovnog kalendara u radnom prostoru Reports (Izvješća) prikazuje se prozor s

podacima izvješća za tri mjeseca.
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Plavi stupci predstavljaju podatke o uređaju. Narančasti stupac predstavlja odabrano

razdoblje izvješćivanja. Ako se podaci s uređaja preklapaju s razdobljem izvješćivanja, to znači

da imate podatke za prikazano razdoblje izvješćivanja ili  za jedan njegov dio.

Područje podatkovnog kalendara prvo prikazuje tri zadnja mjeseca. Da biste vidjeli druge

mjesece, kliknite tipke sa strelicama  s lijeve ili  desne strane prikazanih mjeseci.

Odabir izvora podataka koje želite obuhvatiti

1 Ako bolesnik koristi mjerač razine glukoze u krvi povezan s pumpom, kliknite da biste

odabrali jednu od sljedećih mogućnosti za korištenje podataka mjerača o razini glukoze u

krvi u izvješću:

- In the pump (u pumpi): prednosti su te mogućnosti to što morate pročitati podatke samo

s bolesnikove pumpe, pumpa označava vrijeme na očitanjima razine glukoze u krvi, a

očitanja su izravno povezana s izračunima čarobnjaka za bolus. No ako postoje

poteškoće u komunikaciji između pumpe i povezanog mjerača, u tom razdoblju možda

neće biti prijavljena očitanja razine glukoze u krvi. Osim toga, ako je model pumpe

MiniMed Paradigm koju koristite stariji  od 522/722, očitanja razine glukoze u krvi iz

izračuna čarobnjaka za bolus na koja niste reagirali neće ući u izvješće.

- In the link meter(s) (U povezanom mjeraču): prednost je te mogućnosti prijava svih

očitanja pohranjenih u povezanom mjeraču. Nedostatak je to što ste radi korelacije

podataka iz mjerača i pumpe prethodno morali provjeriti jesu li  pumpa i mjerač

međusobno sinkronizirani. Također morate zasebno pročitati podatke iz pumpe i

povezanog mjerača.

2 Da biste podatke iz uređaja dodali u izvješća, potvrdite okvir pored relevantnog uređaja.

Ne možete dodati uređaje koji su bili isključeni zbog vašeg odabira u 1. koraku. Da biste to

promijenili, odaberite drugu mogućnost povezanog mjerača.

3 Da biste podatke iz uređaja izostavili iz izvješća, poništite potvrdni okvir pokraj relevantnog

uređaja.

Ne možete poništiti potvrdne okvire uz mogućnost koju ste odabrali u 1. koraku. Da biste to

promijenili, odaberite drugu mogućnost povezanog mjerača.

Provjera ima li podataka u uređaju

1 U kalendaru s podacima u radnom prostoru Reports (Izvješća) provjerite preklapa li  se

narančasti stupac, koji predstavlja razdoblje izvješćivanja, s plavim stupcima koji predstavljaju

podatke o uređaju.
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2 Ako se trake preklapaju tijekom cijelog razdoblja izvješćivanja, raspolažete podacima za

izvješće. Možete kliknuti NEXT (Dalje) i  prijeći na odjeljak Provjera postavki izvješća na

stranici 40.

3 Ako se trake ne preklapaju ili  ako nema dovoljno preklapanja, možete odabrati jednu od

sljedećih mogućnosti:

- prilagodite razdoblje izvješćivanja;

- preuzmite dodatne podatke iz uređaja.

Preuzimanje dodatnih podataka iz uređaja

1 Da biste preuzeli više podataka s uređaja, kliknite gumb READ DEVICE (Čitanje uređaja)

pridružen uređaju.

Prikazuje se traka Read Device (Čitanje uređaja).

UPOZORENJE: otkažite ili  dovršite privremene bazalne ili  aktivne boluse i  poništite

eventualno aktivne alarme. Pumpa će se zaustaviti radi očitavanja. Po dovršetku
očitavanja provjerite je li  pumpa nastavila s  radom.

OPREZ: nemojte koristiti  daljinski upravljač za pumpu tijekom očitavanja. Ako je
baterija pumpe slaba, pumpa neće poslati podatke na računalo. Zamijenite bateriju

ako zaslon sa statusom baterije upozorava na to da je slaba.

2 Provjerite jesu li  podaci u polju Choose port  (Odabir priključka) ispravni za taj uređaj.

Da biste promijenili tu postavku, kliknite padajući izbornik za to polje i odaberite neku drugu

postavku.

3 Provjerite je li  uređaj povezan s vašim računalom.

4 Ako je uređaj pumpa, možete odrediti koliko ćete podataka iz nje preuzeti. Kliknite padajući

izbornik Amount of Data  (Količina podataka) i  odaberite količinu.

NAPOMENA: ako odaberete All available data  (Svi dostupni podaci), sustav će
pročitati  sve podatke u pumpi. Time ćete prebrisati sve postojeće udvostručene

podatke u sustavu.

5 Kliknite READ DEVICE  (Čitanje uređaja). Obavezno pažljivo pročitajte prikazanu poruku jer su

u njoj navedene specifične upute za očitavanje pumpe.

6 Slijedite upute i kliknite OK  (U redu).
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Prikazuje se traka napretka pri čitanju s uređaja.

U bilo kojem trenutku možete odustati od čitanja klikom na CANCEL  (Odustani).

Po dovršetku čitanja prikazuje se poruka s potvrdom.

7 Kliknite OK (U redu).

Podaci s uređaja sada su vidljivi na kalendaru s podacima.

8 Kliknite NEXT (Dalje) pri vrhu radnog prostora Reports  (Izvješća).

Prikazuje se korak Verify Report Settings (Provjera postavki izvješća). On omogućuje provjeru

ispravnosti postavki za tog bolesnika prije pokretanja izvješća.

Provjera postavki izvješća

1 Provjerite jesu li  postavke za vrijednost Glucose Target (Ciljana glukoza) u skladu sa željenim

postavkama. Upišite te vrijednosti ili  kliknite strelice prema gore ili  dolje u poljima Low

(Donja) i High (Gornja) da biste povećali ili smanjili vrijednosti.

NAPOMENA: markeri za očitavanje mjerača (||  |) prikazuju se na krivulji  buđenja i
spavanja, kao i na krivulji  obroka. Budući da se neka od ovih izvješća temelje na

podacima iz određenih vremena obroka, buđenja ili  spavanja, važno je da markeri

bolesnikovih Bolus Wizard događaja i  očitanja mjerača budu ispravno grupirani.

2 Da biste dodali novo razdoblje obroka, kliknite ADD MEAL  (Dodaj obrok). Da biste uredili

postojeće razdoblje obroka, kliknite bilo gdje unutar jednog od razdoblja obroka na

vremenskoj crti.

Aktivira se uređivač razdoblja obroka koji se nalazi ispod vremenske crte.

NAPOMENA: možete odrediti do pet razdoblja obroka. Zadani su doručak, ručak i

večera.

3 Unesite tekst ili kliknite strelice da biste odabrali željene postavke.

Ako te postavke želite koristiti samo za taj obrok, poništite potvrdni okvir Use these

parameters for all of this patient’s meals  (Koristi te parametre za sve obroke ovog

bolesnika).

- Meal Name (Naziv obroka): naziv koji želite dodijeliti razdoblju obroka

- Meal Time Period  (Vrijeme obroka): sati između kojih se obrok konzumira

- Pre-Meal BG Target (mg/dL or mmol/L)  (Raspon ciljane glukoze u krvi prije obroka

(mg/dL ili mmol/L)): donje i gornje vrijednosti ciljanog raspona glukoze u krvi bolesnika

prije obroka

- Pre-Meal Analysis Period  vremensko razdoblje u kojemu će se analizirati glukoza prije

početka obroka. Očitanja glukoze zabilježena tijekom tog razdoblja koriste se za detaljnu

analizu izvješća
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- Post-Meal BG Target (mg/dL or mmol/L)  (Raspon ciljane glukoze u krvi poslije obroka

(mg/dL ili mmol/L)): donje i gornje vrijednosti ciljanog raspona glukoze u krvi bolesnika

poslije obroka

- Post-Meal Analysis Period  vremensko razdoblje u kojemu će se analizirati glukoza

nakon obroka. Očitanja glukoze zabilježena tijekom tog razdoblja koriste se za detaljnu

analizu izvješća

Možete promijeniti duljinu postojećeg razdoblja obroka ili razdoblja buđenja i odlaska na

spavanje tako da kliknete ručice početka ili završetka te ih povučete i ispustite duž

vremenske crte.

NAPOMENA: razdoblja obroka ne smiju se preklapati,  no početne i  završne crte smiju
međusobno graničiti.  Razdoblja obroka moraju trajati  barem 60 minuta.

4 Da biste postavke za taj obrok koristili  za sve druge obroke bolesnika, provjerite je li potvrđen

okvir Use these parameters for all of this patient’s meals  (Koristi te parametre za sve

obroke ovog bolesnika).

5 Kada stvorite ili uredite razdoblje obroka, kliknite SAVE  (Spremi).

6 Da biste uklonili razdoblje obroka, kliknite DELETE MEAL  (Izbriši obrok). Kliknite DELETE
(Izbriši) kada se od vas zatraži da potvrdite odluku.

7 CareLink Pro može zapamtiti postavke za tog bolesnika sljedeći put kada pokrenete izvješće

za njega. Da biste spremili postavke za tog bolesnika, kliknite SAVE SETTINGS  (Spremi

postavke).

8 Kliknite NEXT (Dalje) pri vrhu radnog prostora Reports  (Izvješća).
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Time pokrećete korak Select and Generate Reports (Odabir i  generiranje izvješća). Taj korak

pruža popis vrsta izvješća i podatkovnu tablicu uz koju ćete lakše odlučiti hoćete li uvrstiti ili

izostaviti određene dane s podacima iz izvješća Daily Detail (Dnevne pojedinosti).

NAPOMENA: da biste izmijenili  prikaz podatkovne tablice, kliknite >>customize
columns (prilagodi stupce).  Pogledajte odjeljak Preference generiranja izvješća na

stranici  16.

9 Da biste ispisali podatke sa zaslona, kliknite ikonu za ispis PRINT (Ispis) .

Odabir vrsta izvješća i datuma uvrštavanja

1 Potvrdite okvir pokraj izvješća koje želite uvrstiti u skup izvješća.

2 Ako su tijekom tog razdoblja izvješćivanja podaci s pumpe ili monitora Guardian očitani više

puta, možda će postojati više snimki uređaja:

a. Provjerite je li potvrđen okvir Device Settings Snapshot (Snimka postavki uređaja).

b. Kliknite padajuću strelicu i odaberite datum i vrijeme snimke.

- pumpe:  odaberite snimku s pumpe bolesnika

- Guardian:  odaberite snimku s bolesnikova monitora Guardian

Ako je bilo koje od polja zatamnjeno, nema dostupnih snimki tijekom razdoblja izvješćivanja.

3 Prolistajte podatkovnu tablicu da biste pregledali dostupne podatke iz izvješća Daily Detail

(Dnevne pojedinosti).
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- Možete sortirati podatke u svakom stupcu. Kliknite naslov stupca da biste sortirali

podatke uzlaznim redoslijedom. Ponovno kliknite naslov da biste sortirali podatke

silaznim redoslijedom.

NAPOMENA: ako nema podataka za određeni datum, taj datum nije moguće

odabrati.

4 Potvrdite okvir u recima tablice Data Table (Tablica s podacima) za svaki datum za koji želite

izvješće Daily Detail (Dnevne pojedinosti).

- Da biste jednim klikom uvrstili ili izostavili sve datume izvješća Daily Detail (Dnevne

pojedinosti), potvrdite ili poništite okvir pri vrhu stupca s potvrdnim okvirima tablice

Data Table (Tablica s podacima).

Generiranje izvješća

1 Nakon što provjerite odabire izvješća, kliknite GENERATE REPORTS (Generiranje izvješća) pri

vrhu radnog prostora Reports  (Izvješća).

Prikazuje se popis mogućnosti.

2 Odaberite mogućnost za pretpregled, ispis ili spremanje izvješća.

Ako ste odabrali Preview (Pretpregled), prikazuje se prozor Preview  (Pretpregled).

3 Kliknite tipke sa strelicama da biste se kretali kroz izvješća koja sadrže više stranica.

4 Kliknite jedan od ostalih gumba pri vrhu prozora Preview (Pretpregled) da biste spremili ili

ispisali izvješće.

5 Da biste zatvorili  taj prozor, kliknite gumb Close (Zatvori)  u gornjem desnom kutu prozora.

O izvješćima

Ovaj odjeljak sadrži opis svakog izvješća. U referentnom vodiču za izvješća navedene su

dodatne pojedinosti  o komponentama izvješća, kao i  uzorci  izvješća. Referentnom vodiču za

izvješća možete pristupiti iz programa CareLink Pro:

1 Help > View Report Reference Guide (PDF)  (Pomoć > Prikaz referentnog vodiča za izvješća

(PDF)).

2 Odaberite jezik referentnog vodiča za izvješća.

Izvješća softvera CareLink Pro imaju ove zajedničke elemente:

• Report header (Zaglavlje izvješća) – sadrži podatke za identifikaciju, primjerice naziv izvješća,

ime bolesnika i izvor podataka.

• Carbohydrates and blood glucose levels  (Razine ugljikohidrata i glukoze u krvi) – u

grafikonima i dijagramima jedinice ugljikohidrata prikazane su kurzivom, a razine glukoze u

krvi podebljano.

CareLink Pro Korisnički priručnik   Radni prostor Reports (Izvješća) 43



• Weekend data  (Podaci o vikendu) – dani vikenda podebljani su da biste ih mogli

jednostavno prepoznati.

• Legends  (Kazalo) – kazalo simbola pojavljuje se pri dnu svakog izvješća. Dok je simbol

moguće koristiti u više izvješća, kazala su jedinstvena za svako izvješće.

Izvješće o pridržavanju propisane terapije

U izvješću Adherence Report (Izvješće o pridržavanju propisane terapije) prikazani su podaci

koji opisuju kako se koriste inzulinske pumpe i senzori,  a opisano je i ponašanje bolesnika

relevantno za terapiju koju primaju. Izvješće odgovara na pitanje: »Je li  bilo dovoljno podataka

za točan prikaz načina na koji bolesnik koristi inzulinsku pumpu i senzor (ako je primjenjivo)?«.

Ono odgovara i na pitanje: »Pridržavaju li  se bolesnici terapije prema uputama?«. Izvješće uz

to daje naznake o tome trebate li  razgovarati  s bolesnikom o njegovu načinu kontrole

dijabetesa.

Izvješće s pregledom senzora i mjerača

Izvješće o pregledu senzora i  mjerača pruža grafički prikaz dnevnih razina i prosjeka glukoze u

krvi bolesnika dobivenih iz mjerača, uključujući i  podatke za svaki sat tijekom 24 sata te njihov

odnos s obrocima i spavanjem. Uvršteni su i statistički podaci o očitanjima razine glukoze u

krvi bolesnika i korištenju inzulina.

Ako su dostupni podaci iz senzora, generira se slična analiza podataka iz senzora kao prva

stranica ovog izvješća. Ako podaci iz senzora nisu dostupni,  stranica s analizom podataka

mjerača generira se kao prva stranica.

Na zadnjoj stranici izvješća prikazane su dnevne razine i  kvaliteta kontrole glukoze,

ugljikohidrata i inzulina bolesnika. Na svakoj je stranici prikazano kako kontrola varira svakog

dana tijekom cijelog razdoblja izvješćivanja do najviše 14 dana po stranici.

Izvješće zapisnika

Izvješće zapisnika prikazuje podatke o mjeraču glukoze, ugljikohidratima i inzulinu za svaki

dan odabranog razdoblja. Ono sadrži dnevnik događaja zabilježenih svakog sata te dnevne

prosjeke i ukupne podatke. Svaka stranica sadrži podatke za najviše 14 dana. Ako razdoblje

izvješćivanja premašuje 14 dana, generiraju se dodatne stranice.

Snimka postavki uređaja

U izvješću Device Settings Snapshot Report (Snimka postavki uređaja) prikazuje se snimka

postavki bolesnikove pumpe ili  monitora Guardian REAL-Time za određeni datum i vrijeme.'

To vam može olakšati  razumijevanje drugih izvješća ili  jednostavno dokumentirati  postavke

bolesnika.

Postavke pumpe ili  monitora snimaju se samo pri očitavanju uređaja. Ako uređaj nije očitan

tijekom razdoblja izvješćivanja, nikakve postavke neće biti  dostupne.
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Izvješće o dnevnim pojedinostima

U izvješću s dnevnim pojedinostima prikazani su podaci o razini  glukoze, količini

ugljikohidrata i bolesnikovu korištenju inzulina za odabrani dan. Za svaki dan koji odaberete iz

podatkovne tablice generira se zasebno izvješće.

Izvješće Daily Detail Report (Dnevne pojedinosti) pruža detaljan uvid u odabrani dan. Ono

vam omogućuje da se usredotočite na određeni dan ako smatrate da se tada dogodilo nešto

važno za terapiju bolesnika.

Izvoz podataka

Možete izvesti podatke s uređaja koje je CareLink Pro pribavio i  pohranio. Tako sve podatke s

uređaja bolesnika možete koristiti u statistikama ili  za stvaranje specijaliziranih izvješća ili

grafikona. Datoteku .csv možete uvesti u Microsoft Excel ili  neke programe za kliničku

statistiku te zatim njima dalje upravljati.

Datoteka .csv sadrži podatke u kojima su zabilježene radnje uređaja. Navedeni su, primjerice,

snimka očitanja mjerača, pumpa koja prima vrijednost očitanja mjerača ili  promjena bazalnog

ritma.

NAPOMENA: to je napredna značajka za koju morate poznavati neobrađene podatke s

uređaja. Potrebno je i  dobro poznavanje softvera u koji ćete uvesti .csv datoteku.

Slijedite ove korake da biste koristili  značajku izvoza programa CareLink Pro:

1 Kliknite karticu bolesnika ili gumb Open Patient (Otvori bolesnika)  pa dvokliknite

njegovo ime.

2 Provjerite je li  otvoren radni prostor Reports (Izvješća).

3 Koristite polje Duration (Trajanje) ili  From/Through  (Od/Do) da biste postavili datume i

duljinu izvješća.

Maksimalno trajanje koje možete odabrati iznosi 12 tjedana.

4 Kliknite vezu export selected data  (izvoz odabranih podataka).

Prikazuje se dijaloški okvir Export Data to CSV File (Izvoz podataka u CSV datoteku).

5 Idite na mjesto na računalu na kojem želite spremiti .csv datoteku. Ako želite promijeniti

naziv datoteke, upišite ga u okvir File name (Naziv datoteke).

6 Kliknite SAVE  (Spremi).

NAPOMENA: dodatne informacije o podacima prikazanima u CSV datotekama

potražite u odjeljku o CSV podacima.

Datoteka s nastavkom .csv sada je spremljena na odabranom mjestu na vašem računalu.

Sada možete izvršiti njezin uvoz u bilo koji program koji podržava tu vrstu datoteka.
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Administracija sustava

Važno je da redovito stvarate sigurnosne kopije baze podataka programa CareLink Pro. U bazi

podataka pohranjeni su svi sistemski podaci akumulirani u zapisima o bolesniku, uključujući

informacije o profilu, podatke dobivene iz uređaja i postavke izvješća.

Važno je i da imate najnoviju verziju programa CareLink Pro. S vremena na vrijeme dostupne

su ažurirane verzije koje mogu sadržavati  važna poboljšanja. Možete potražiti ažuriranja ili

primiti obavijest kada su ažuriranja dostupna.

Primjena ažuriranja softvera

Povremeno su dostupna ažuriranja programa CareLink Pro. Kada se prikaže obavijest o

ažuriranju, poduzmite slijedeće korake da biste preuzeli najnovije izdanje softvera.

NAPOMENA: potrebno je stvoriti sigurnosnu kopiju baze podataka prije primjene
ažuriranja softvera. Pogledajte odjeljak Stvaranje sigurnosne kopije baze podataka na

stranici  47.

1 Provjerite je li  internetska veza dostupna i aktivna na vašem računalu.

2 Kada je ažuriranje za CareLink Pro dostupno, prikazuje se poruka o ažuriranju. Nudi se

mogućnost preuzimanja ažuriranja.

3 Kliknite DOWNLOAD (Preuzimanje). (Ako kliknete CANCEL  (Odustani), obavijest o ažuriranju

će se zatvoriti. Ažuriranje možete preuzeti kasnije.)

Prikazuje se poruka upozorenja u kojoj se preporučuje da stvorite sigurnosnu kopiju baze

podataka.

4 Kliknite YES (Da) da biste stvorili  sigurnosnu kopiju baze podataka (opis tog postupka

potražite u odjeljku Stvaranje sigurnosne kopije baze podataka na stranici 47). Kliknite gumb

NO  (Ne) ako ste već obavili ažuriranje podataka.

Prikazat će se poruka kojom se potvrđuje da je preuzeta nova verzija programa CareLink Pro.
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5 Da biste počeli koristiti najnoviju verziju programa CareLink Pro, kliknite YES (Da) da biste

zatvorili i ponovno otvorili  program. Kliknite NO (Ne) ako ne želite odmah ponovno

pokrenuti CareLink Pro.

Isključivanje automatskih ažuriranja

Ako ne želite primati automatske obavijesti o ažuriranjima programa CareLink Pro, slijedite ove

korake:

1 Odaberite Tools  > Options (Alati, Mogućnosti).

2 Kliknite karticu General (Općenito).

3 U odjeljku Communications (Komunikacija), poništite potvrdni okvir Automatically check

for software updates (Automatski provjeri ima li ažuriranja softvera).

Ručna provjera dostupnosti ažuriranja

U svakom trenutku možete ručno provjeriti jesu li  dostupna ažuriranja za CareLink Pro.

NAPOMENA: potrebno je stvoriti sigurnosnu kopiju baze podataka prije primjene

ažuriranja softvera. Pogledajte odjeljak Stvaranje sigurnosne kopije baze podataka na

stranici  47.

1 Provjerite je li  internetska veza dostupna i aktivna na vašem računalu.

2 Odaberite Tools > Check for Software Updates  (Alati, Provjeri ima li ažuriranja programa).

3 Ako trenutno nema dostupnih ažuriranja, primit ćete poruku. Ako je ažuriranje dostupno,

prikazuje se poruka o ažuriranju softvera CareLink Pro.

4 Slijedite postupak u odjeljku Primjena ažuriranja softvera na stranici 46.

Stvaranje sigurnosne kopije i povrat baze podataka

Preporučujemo da uspostavite redoviti raspored prema kojem ćete stvarati sigurnosne kopije

baze podataka. Na taj ćete način osigurati redovito stvaranje kopija baze podataka i

minimizirati rizik gubitka podataka.

Ako stvarate sigurnosnu kopiju ili  vraćate bazu podataka, pojavit će se upozorenje ako na

drugim računalima korisnici aktivno koriste program.

Stvaranje sigurnosne kopije baze podataka

Sljedeći koraci opisuju sigurnosno kopiranje trenutne baze podataka na mjesto koje odaberete.

1 Provjerite jesu li  svi zapisi o bolesnicima zatvoreni.

2 Odaberite Tools > Backup Database (Alati > Sigurnosno kopiranje baze podataka).
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NAPOMENA: sigurnosne kopije baze podataka mogu se spremiti na mrežni pogon ili

na izmjenjivi medij za pohranu (DVD, CD ili  USB pogon).

3 Idite na mjesto na računalu na kojem želite spremiti sigurnosnu kopiju. Ako želite promijeniti

naziv datoteke sigurnosne kopije, upišite ga u okvir File name  (Naziv datoteke).

4 Kliknite Spremi.  Traka napretka prikazuje se tijekom spremanja baze podataka.

Kada je sigurnosno kopiranje dovršeno, prikazuje se poruka.

5 Kliknite OK (U redu) da biste zatvorili poruku.

Povrat baze podataka

Možda je potrebno zamijeniti trenutnu bazu podataka ako joj više nije moguće pristupiti ili

je više nije moguće koristiti.  Što je vaša sigurnosna kopija ažurnija,  izgubit ćete manje

podataka ako zamijenite bazu podataka.

OPREZ: kada izvršite povrat sa sigurnosnom kopijom, gubite sve nove podatke stvorene
od trenutka kada ste načinili  odabranu sigurnosnu kopiju.

Sljedeći koraci opisuju odabir sigurnosne kopije kojom ćete zamijeniti trenutnu bazu podataka.

1 Provjerite jesu li  svi zapisi o bolesnicima zatvoreni.

2 Odaberite Tools > Restore Database  (Alati > Povrat baze podataka).

3 Odaberite datoteku sigurnosne kopije kojom želite zamijeniti trenutnu bazu podataka

(obično je to najnovija).

4 Kliknite Open  (Otvori). Prikazuje se poruka s upozorenjem da ćete možda izgubiti podatke

ako nastavite vraćanje baze podataka.

5 Za nastavak kliknite OK (U redu). Traka napretka prikazuje se tijekom povrata baze podataka.

Po završetku povrata baze podataka prikazuje se poruka.

6 Kliknite OK (U redu) da biste zatvorili poruku.

Ako sustav nije dostupan

Ako pokušate pokrenuti sustav dok drugi korisnik izvršava sigurnosno kopiranje ili  vraćanje,

prikazat će se poruka s obavijesti da sustav nije dostupan. Nećete moći pristupiti  sustavu dok

se zadatak ne dovrši.

Učinite nešto od navedenog:

• Pričekajte da postupak završi i  da sustav postane dostupan.

• Kliknite CANCEL  (Odustani) da biste izašli iz programa i pokušali ponovno kasnije.
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Otklanjanje poteškoća

Ovo poglavlje olakšat će vam rješavanje problema do kojih može doći tijekom korištenja

programa CareLink Pro. Ono sadrži i  upute za eventualnu deinstalaciju programa CareLink Pro.

Opće pogreške pri korištenju programa

Ako pokušate preuzeti nadogradnju softvera putem interneta, mogli biste primiti poruku da

nemate dovoljne ovlasti za to. Morate imati administrativne ovlasti da biste preuzimali

nadogradnje za program CareLink Pro.

1 Zatvorite CareLink Pro i ponovno pokrenite računalni sustav.

2 Neka se osoba s administrativnim ovlastima prijavi na računalo.

3 Slijedite upute u odjeljku Primjena ažuriranja softvera na stranici 46.

Ne postoji veza s bazom podataka

Poruka o pogrešci koja vas upozorava da niste povezani s bazom podataka upućuje na nešto

od navedenog:

• Baza podataka je premještena. Baza podataka mora se nalaziti na mjestu koje ste odabrali

tijekom instalacije programa CareLink Pro. Ako je premještena, morate je vratiti na mjesto

odabrano tijekom instalacije.

• Niste povezani s mrežnim pogonom na kojem se baza podataka nalazi. Ako se baza podataka

nalazi na mrežnom pogonu, na mreži se povremeno mogu pojaviti problemi koji mogu

spriječiti pristupanje pogonu. Obratite se odjelu za računalnu podršku da biste dobili pomoć

za ponovno povezivanje s mrežnim pogonom na kojem se nalazi baza podataka.
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Zaboravili ste lozinku ambulante za CareLink Pro

Ako se nitko ne može sjetiti  lozinke koju vaša ustanova koristi  za prijavu u CareLink Pro,

morate ponovno instalirati program i stvoriti novu bazu podataka. Kada ponovno instalirate

softver, nećete moći pristupiti  informacijama o bolesniku koje su se nalazile u prijašnjoj bazi

podataka. Lozinku koju stvorite tijekom nove instalacije pohranite negdje u uredu da ne biste

izgubili  buduće podatke.

Pogreška pri čitanju uređaja

Pogreška Objašnjenje

The selected serial port could not be opened. Another
operation might be in progress on that port. Please
wait until the port is  available, or select another port.
(Nije bilo moguće otvoriti odabranu serijsku
priključnicu. Možda je u tijeku neka druga operacija na
toj priključnici.  Pričekajte dok priključnica ne postane
dostupna ili  odaberite neku drugu priključnicu.)

Provjerite ne koristi li  neki drugi program odabranu
komunikacijsku priključnicu ili  odaberite neku
drugu priključnicu. Pokušajte ponovno pokrenuti
računalo koje koristite i  potom ponovno pročitati
uređaj. Možda je neispravan hardver (kabel itd.)
povezan s priključnicom ili  sama priključnica.
Povežite hardver s nekom drugom priključnicom i
ponovno pokušajte pročitati uređaj da biste lakše
odredili  problem.

Auto Detect could not find the device on any available
port. Please check the cable connection, device battery
& status and try again, or try specifying a serial port.
(AutoDetect nije uspio pronaći uređaj na dostupnoj
priključnici.  Provjerite kabelsku priključnicu, bateriju i
stanje uređaja i pokušajte ponovno ili  pokušajte
specificirati serijsku priključnicu.

Provjerite vezu između kabela i računala te
provjerite je li  status baterije uređaja
zadovoljavajući.  Ako jest,  umjesto odabira značajke
automatskog otkrivanja pokušajte odrediti serijsku
priključnicu računala s kojom je kabel povezan.

Device not found at selected serial port. Please check
the cable connection, device battery & status and try
again, try selecting a different port, or try to Auto
Detect the device. (Uređaj nije pronađen na odabranoj
serijskoj priključnici.  Provjerite kabelsku vezu, bateriju
uređaja i status pa pokušajte ponovno ili  pokušajte
odabrati neku drugu priključnicu ili  automatski otkriti
uređaj.)

Provjerite vezu između kabela i računala te
provjerite je li  status baterije uređaja
zadovoljavajući.  Ako jest,  pokušajte odabrati neki
drugi broj serijske priključnice računala ili  odaberite
mogućnost automatskog otkrivanja.

Unable to communicate with the device. Please ensure
you’ve attached and selected the correct device, check
the cable connection, device battery and status, and try
again. (Komunikacija s  uređajem nije moguća. Provjerite
jeste li  priključili  i  odabrali odgovarajući uređaj,
provjerite kabelsku vezu, bateriju uređaja i status pa
pokušajte ponovno.)

Provjerite sve odabrane postavke za čitanje
uređaja, uključujući naziv uređaja, serijski broj i
vrstu veze. Provjerite uz to jesu li  uređaj, kabel i
računalo ispravno povezani. Provjerite jesu li
baterija i  status alarma uređaja zadovoljavajući.
Ponovno pokušajte izvršiti čitanje.

Unexpected response...  retrying (n%) (Neočekivani
odgovor...  pokušavam ponovno (n%))

S uređaja je pročitana neočekivana vrijednost.
Sustav pokušava ponovno uspostaviti komunikaciju
sve dok ne odustanete ili  dok komunikacija ne
uspije.

The link device was found, but the device (<serial #>) is
not responding. Please verify the pump’s serial number,
place the pump closer to the communication device to
minimize interference, check pump battery and status.
(Komunikacijski je uređaj pronađen, no pumpa (serijski
br.) ne odgovara. Provjerite serijski broj pumpe,
postavite je bliže komunikacijskom uređaju da biste
minimizirali smetnje te provjerite bateriju pumpe i
status.)

Provjerite jeste li  unijeli ispravan serijski broj
pumpe. Ako niste, ponovno unesite ispravan
serijski broj. Ako je serijski broj ispravan, pokušajte
uređaj za povezivanje približiti  komunikacijskom
uređaju. Pomaknite uređaj za povezivanje i
komunikacijski uređaj podalje od mogućih smetnji
(primjerice RF uređaja). Provjerite bateriju uređaja i,
ako učitavate pumpu za inzulin, provjerite stanje
rada pumpe.

This pump is delivering a temp basal. Please cancel the
temp basal or wait until it completes, and then try
again. (Pumpa isporučuje privremenu bazalnu dozu.
Otkažite bazalnu dozu ili  pričekajte dok ne završi,  a zatim
pokušajte ponovno.)

Pumpa koju pokušavate pročitati isporučuje
privremenu bazalnu dozu. Pričekajte dok
privremena bazalna isporuka ne završi da biste
pročitali pumpu ili  otkažite privremenu bazalnu
dozu i potom pročitajte pumpu.
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Pogreška Objašnjenje

This pump has active errors or alarms. Please clear the
alarms and try again. (Na pumpi su aktivne pogreške ili
alarmi. Poništite alarme i pokušajte ponovno.)

Na pumpi su aktivni  alarmi koji sprječavaju čitanje.
Pročitajte upute za alarm da biste doznali kako ga
poništiti.  Poništite alarm i pokušajte ponovno
pročitati pumpu.

This pump is delivering a bolus. Please cancel the bolus
or wait until it completes, and then try again. (Pumpa
isporučuje bolus. Otkažite bolus ili  pričekajte dok ne
završi,  a zatim pokušajte ponovno.)

Pumpa koju pokušavate pročitati isporučuje bolus.
Pričekajte dok bolus ne završi da biste pročitali
pumpu ili odustanite od bolusa i potom pročitajte
pumpu.

The device returned invalid entries; all data read will be
discarded. (Uređaj je poslao nevaljane unose; svi
pročitani podaci bit će odbačeni.)

Obratite se lokalnom predstavniku u svojoj zemlji
(pogledajte odjeljak Pomoć na stranici  2).

Pogreške pri stvaranju izvješća

Više podatkovnih unosa za isti datum

Ako postoji više podatkovnih unosa za isti datum i  vrijeme za isti uređaj,  sustav će to

protumačiti  kao sukob koji nije moguće razriješiti.  Izvješća stvorena pomoću tih podataka s

uređaja neće sadržavati podatke koji se preklapaju.

Možete pokušati  prilagoditi razdoblje izvješća da biste zaobišli podatke koji se preklapaju ili

ukloniti uređaj iz sustava i potom ga vratiti da biste poništili  prethodna očitanja.

Sustav ignorira podatke

Ako je vrijeme na uređaju promijenjeno te rezultira preklapanjem podataka ili  prazninama

između podataka u trajanju od tri sata ili  dulje, sustav ne uvrštava taj dio podataka pri

stvaranju izvješća.

Pogreške prilikom sigurnosnog kopiranja i vraćanja

Bazu podataka nije moguće zaključati

To znači da sustav koristite u okruženju s više korisnika, a drugi su korisnici  prijavljeni.  Sustav

neće dopustiti  stvaranje sigurnosne kopije baze podataka dok drugi korisnici izvršavaju

zadatke koji mogu utjecati na bazu podataka. Nakon što svi korisnici izađu iz programa

CareLink Pro, možete stvoriti sigurnosnu kopiju baze podataka.

Sigurnosno kopiranje ili vraćanje baze podataka ne izvršava se do kraja

Drugi se korisnici ne mogu prijaviti,  a sigurnosno kopiranje ili  vraćanje nije moguće dovršiti.

Obratite se lokalnom predstavniku u svojoj  zemlji (pogledajte odjeljak Pomoć na stranici  2).

Vraćanje baze podataka ne uspijeva

Datoteka sigurnosne kopije baze podataka koju pokušavate koristiti  za vraćanje je oštećena.

Pokušajte izvršiti vraćanje s nekom drugom datotekom sigurnosne kopije.
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Deinstalacija softvera

Ako želite deinstalirati CareLink Pro, poduzmite sljedeće korake:

1 Otvorite odjeljak Control Panel (Upravljačka ploča) putem izbornika Start u sustavu Windows.

2 Odaberite Add or Remove Programs (Dodaj ili ukloni programe). Prikazuje se prozor »Add

or Remove Programs« (Dodaj ili ukloni programe) u sustavu Windows.

3 Pomaknite se dolje do programa Medtronic Carelink Pro  i kliknite ga.

4 Kliknite Remove  (Ukloni). Prikazuje se Install Shield Wizard (Čarobnjak za instalaciju).

5 Kliknite Next  (Dalje). Prikazuje se poruka u kojoj morate potvrditi da želite ukloniti program.

6 Kliknite Yes  (Da). Pokreće se program za deinstalaciju koji s računala uklanja program i sve

njegove datoteke. Po završetku deinstalacije na zaslonu čarobnjaka prikazuje se poruka koja

potvrđuje deinstalaciju.

7 Kliknite Finish (Završi).
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9

Tablica s ikonama

Ikone i simboli na ambalažnim naljepnicama i opremi opisani su u sljedećoj tablici:

Opis Ikona

Jedan komad po kutiji/pakiranju (1X)

Priložen CD

Pažnja: Pročitajte sva upozorenja i mjere opreza u
korisničkom priručniku.

Datum proizvodnje (godina)

Kataloški broj

Conformité Européene (European Conformity). Taj simbol
znači da je uređaj u potpunosti usklađen s Direktivama
MDD 93/42/EEZ i R&TTE 1999/5/EZ.
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A

CSV podaci

Kada izvozite podatke iz programa CareLink Pro, oni se izvoze u .csv datoteku. Ta se datoteka

može uvesti  u aplikaciju koja koristi radne listove, kao što je Microsoft Excel.  U definicijama

stupaca u CSV datoteci možete pronaći potpuni opis podataka koji mogu biti  sadržani u CSV

datoteci.

CSV datoteka sadrži  ime i identifikaciju bolesnika i razdoblje izvješćivanja te identificira sve

uređaje koji se nalaze u izvješću.

Definicije podataka u stupcima

Naslov stupca Definicija

Index (Kazalo) Redoslijed kojim su podaci snimljeni na uređaj.

Date (Datum) Datum na koji su podaci snimljeni na uređaj.

Time (Vrijeme) Vrijeme u koje su podaci snimljeni na uređaj.

New Device Time (Novo vrijeme uređaja) Novi datum i vrijeme ako su oni promijenjeni na
uređaju.

BG Reading (mg/dL or mmol/L) (Očitanje glukoze u
krvi (mg/dL ili  mmol/L))

Očitanje razine glukoze u krvi zabilježeno mjeračem,
monitorom Guardian ili  pumpom. Ako podaci potječu
iz pumpe ili  monitora Guardian, u tom je stupcu
prikazana ručno izmjerena razina glukoze u krvi i
razina primljena s povezanog mjerača.

Linked BG Meter ID (ID povezanog mjerača glukoze u
krvi)

Serijski broj mjerača koji šalje očitanja razine glukoze
u krvi na uređaj.

Basal  Rate (U/h) (Bazalna stopa (J/h)) Brzina isporuke aktivnog bazalnog inzulina u
jedinicama po satu.

Temp Basal Amount (Količina privremenog bazalnog
inzulina)

Ako je privremeni bazalni inzulin primijenjen na
pumpi, ta vrijednost označava količinu privremenog
bazalnog inzulina.

Temp Basal Type (Vrsta privremenog bazalnog
inzulina)

Namještanje vrste privremenog bazalnog inzulina
(stopa inzulina ili  postotak bazalnog).

Temp Basal Duration (m) (Trajanje privremenog
bazalnog inzulina (min.))

Vrijeme u minutama za isporuku privremenog
bazalnog inzulina (vidi vrstu gore).
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Naslov stupca Definicija

Bolus Type (Vrsta bolusa)
Vrsta isporuke bolusnog inzulina [normalni,
četvrtasti,  dvojni (normalni dio) ili  dvojni (četvrtasti
dio)].

Bolus Volume Selected (U) (Odabrana količina bolusa
(J))

Broj jedinica inzulina odabranih za isporuku tijekom
isporuke inzulina u bolusu.

Bolus Volume Delivered (U) (Isporučena količina bolusa
(J))

Broj jedinica inzulina koje su zapravo isporučene
tijekom isporuke inzulina u bolusu.

Programmed Bolus Duration (h) (Programirano trajanje
bolusa (h))

Trajanje četvrtastog bolusa ili  četvrtastog dijela
bolusa s dvojnim valom.

Prime Type (Vrsta početnog ciklusa)

Ručni ili  fiksni. Ručni početni ciklus koristi se samo
nakon prematanja,  za ispunjavanje kompleta
infuzijskih cijevi inzulinom prije uvođenja. Fiksno
pokretanje koristi se nakon umetanja cijevi za infuziju
za ispunjavanje meke kanile inzulinom nakon
uklanjanja igle uvodnika.

Prime Volume Delivered (U) (Isporučena količina
početnog ciklusa (J))

Broj jedinica inzulina koje su zapravo isporučene za
početni ciklus.

Alarm Naziv alarma koji se aktivirao.

Suspend (Prekid) Utvrđuje prekinuto stanje pumpe.

Rewind (Prematanje) Datum i sat kada je uređaj premotan.

BWZ Estimate (U) (BWZ procjena (J))
Procjena količine inzulina u bolusu ako je izračunata
značajkom čarobnjaka za bolus (Bolus Wizard) na
pumpi Paradigm.

BWZ Target High BG (mg/dL or mmol/L) (Gornja ciljna
razina glukoze u krvi za BWZ (mg/dL ili  mmol/L))

Postavke za gornji dio raspona ciljne razine glukoze u
krvi koje koristi značajka čarobnjaka za bolus (Bolus
Wizard).

BWZ Target Low BG (mg/dL or mmol/L) (Donja ciljna
razina glukoze u krvi za BWZ (mg/dL ili  mmol/L))

Postavke za donji dio raspona ciljne razine glukoze u
krvi koje koristi značajka čarobnjaka za bolus (Bolus
Wizard).

BWZ Carb Ratio (Omjer ugljikohidrata za BWZ)

Postavka za omjer inzulina i ugljikohidrata. Ako se
kao jedinice koriste grami, omjer je broj grama
pokriven jednom jedinicom inzulina. Ako se kao
jedinice koriste razmjene, omjer je broj jedinica
inzulina potreban za pokrivanje jedne razmjene.

BWZ Insulin Sensitivity (Osjetljivost inzulina za BWZ)

Postavka za osjetljivost inzulina. Osjetljivost inzulina
količina je za koju jedna jedinica inzulina smanjuje
razinu glukoze u krvi.  Te podatke koristi značajka
čarobnjaka za bolus (Bolus Wizard).

BWZ Carb Input (Unos ugljikohidrata za BWZ) Količina ugljikohidrata unesena u čarobnjak za bolus
(Bolus Wizard) koja se koristi za procjenu bolusa.

BWZ BG Input (mg/dL or mmol/L) (Unos razine glukoze
u krvi za BWZ (mg/dL ili  mmol/L))

Očitanje glukoze u krvi uneseno u čarobnjak za
bolus (Bolus Wizard) koje se koristi za procjenu
bolusa.

BWZ Correction Estimate (U) (Ispravak procjene BWZ-a
(J))

Jedinice inzulina u bolusu radi korekcije razine
glukoze u krvi,  izračunate pomoću značajke
čarobnjaka za bolus (Bolus Wizard).

BWZ Food Estimate (U) (Procjena hrane za BWZ (J))

Procijenjene jedinice inzulina u bolusu koje je
potrebno dati radi pokrivanja očekivane količine
potrošenih ugljikohidrata, izračunate putem značajke
Bolus Wizard.

BWZ Active Insulin (U) (Aktivni inzulin za BWZ (J))

Količina aktivnog inzulina izračunata kao preostala u
tijelu iz prijašnjih isporuka inzulina u bolusu pri
određivanju procijenjene količine bolusa putem
značajke čarobnjaka za bolus (Bolus Wizard).
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Naslov stupca Definicija

Sensor Calibration BG (mg/dL or mmol/L) (Razine
glukoze u krvi za kalibraciju senzora (mg/dL ili
mmol/L))

Vrijednost razine glukoze u krvi koja se koristi  za
kalibraciju senzora u mg/dL ili  mmol/L.

Sensor Glucose (mg/dL or mmol/L) (Glukoza na
senzoru (mg/dL ili  mmol/L)) Vrijednost glukoze senzora.

ISIG value (Vrijednost ISIG) Ulazni signali (ISIG) koje očitava senzor, izraženi u
nanoamperima (nA).

Više pojedinosti o CSV datotekama koje izvozi CareLink Pro

Naslov na vrhu CSV datoteke obuhvaća sljedeće:

• ime bolesnika

• popis odabranih uređaja i njihovih serijskih brojeva

• odabrani raspon datuma

Svaki blok stupaca ima naslov koji  obuhvaća sljedeće:

• naziv uređaja na koji se blok podataka primjenjuje

• serijski broj tog uređaja

Ako se podaci ne prikazuju prema očekivanjima

Postoje brojni različiti faktori  koji  mogu uzrokovati da prikaz CSV podataka bude drukčiji  od

očekivanog.

• Promjene datuma ili vremena na uređaju mogu promijeniti redoslijed zapisa ili  uzrokovati

prikaz zapisa izvan odabranog raspona datuma.

• Ako između čitanja uređaja postoji veliki razmak, podaci za taj uređaj mogu biti prikazani u

više blokova.
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Rječnik

A1C -  Glikozilirani hemoglobin

Bazalna stopa inzulina - Postavka pumpe koja pruža trajnu infuziju inzulina radi održavanja stabilne
razine glukoze u krvi između obroka i tijekom noći. Bazalni inzulin oponaša isporuku inzulina iz
gušterače, koji ispunjava sve potrebe tijela za inzulinom nevezano za hranu.

Bazalni inzulin - Infuzija inzulina koju automatski svakog sata isporučuje inzulinska pumpa na
temelju unaprijed programiranih profila i personaliziranih stopa postavljenih u pumpi. Pumpa
isporučuje dnevnu infuziju inzulina koja obično pokriva "pozadinske" potrebe za inzulinom
tijekom razdoblja posta (primjerice tijekom noći i između obroka).

Bolus četvrtastog vala (Square Wave® bolus) - Bolus koji se isporučuje ravnomjerno tijekom
određenog vremenskog razdoblja (30 minuta do osam sati).

Bolus dvostrukog vala (Dual Wave® bolus) - Kombinacija normalnog bolusa, koji se odmah
isporučuje, i četvrtastog (Square Wave) bolusa. Četvrtasti se dio ravnomjerno isporučuje tijekom
određenog vremenskog razdoblja.

Bolus hrane - Doza inzulina koja se daje za pokrivanje očekivanog porasta glukoze u krvi do kojeg
dolazi nakon jela.

Bolus ispravljanja - Količina inzulina potrebna za povrat visoke razine glukoze u krvi natrag u ciljni
raspon.

CareLink® Personal - Internetska usluga koja omogućuje upravljanje podacima o dijabetesu putem
interneta.

CH - Ugljikohidrati

ComLink - Uređaj za primopredaju radijskih frekvencija (RF) koji se koristi za preuzimanje podataka
iz pumpe Paradigm na računalo.

Com-Station - Uređaj koji se koristi za preuzimanje podataka iz pumpe MiniMed 508 i prolaznih
podataka iz mjerača drugih proizvođača na računalo.

Dio četvrtastog vala (Square Wave) - (Sq) Drugi dio bolusa dvojnog vala (Dual Wave). Četvrtasti se
dio ravnomjerno isporučuje tijekom određenog vremenskog razdoblja nakon isporuke trenutnog
dijela.

Donja razina glukoze - Pumpa će aktivirati alarm ako senzor upućuje na to da je glukoza korisnika
na senzoru jednaka toj vrijednosti ili veća od nje. Tu značajku možete uključiti i isključiti.

Easy Bolus™ - Metoda isporuke normalnog bolusa korištenjem gumba Easy Bolus na pumpi.

Ekspresni bolus - Metoda isporuke bilo koje vrste bolusa putem gumba express bolus (ekspresni
bolus) na pumpi.

Faktor korekcije bolusa - Koliko će 1,0 jedinica inzulina spustiti vašu razinu glukoze u krvi. Taj se
faktor koristi za izračun količine bolusa ispravljanja u krvi kada je razina šećera u krvi visoka. (Razina
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glukoze u krvi) - (ciljna razina glukoze u krvi) = X. X ÷ (faktor korekcije bolusa) = količina korekcije
bolusa.

GK - Kratica za glukozu u krvi

Gornja razina glukoze - Pumpa će aktivirati alarm ako senzor upućuje na to da je glukoza korisnika
na senzoru jednaka toj vrijednosti ili veća od nje. Tu značajku možete uključiti i isključiti.

HbA1c - Glikozilirani hemoglobin

Hiperglikemija - Povišena razina glukoze u krvi ustanovljena nadzorom razina glukoze u krvi. Može
obuhvaćati navedene simptome ili neke od njih: mučnina, povraćanje, zamagljen vid, glavobolja,
želučane poteškoće, često mokrenje uz velike količine mokraće i letargija.

Hipoglikemija - Niska razina glukoze u krvi ustanovljena nadzorom razina glukoze u krvi. Može
obuhvaćati navedene simptome ili neke od njih: prekomjerna glad, drhtanje ili tremori, znojenje,
"plešuće" slike pred očima, vrtoglavica, glavobolja, nejasan govor, nagle promjene raspoloženja
ili promjena osobnosti.

ID odašilj. - Serijski broj odašiljača koji se trenutno koristi.

Inzulin u bolusu - Doza inzulina koja se daje radi pokrivanja neočekivanog porasta glukoze u krvi
(primjerice nakon obroka ili međuobroka) ili za snižavanje visoke razine glukoze na ciljani raspon.

ISIG - Vrijednosti senzora iz kojih se vidi funkcionira li pravilno elektronika odašiljača u sustavu
poboljšanom senzorima. Ako opazite vrijednost ISIG manju od 24,00 nA ili veću od 29,00 nA,
zatražite pomoć za proizvod. Možda je vrijeme da zamijenite odašiljač.

Jedinice ugljikohidrata - Unos hrane pri korištenju čarobnjaka Bolus Wizard. Unosi se kao grami ili
razmjene (ugljikohidrata).

Komplet za infuziju - Uređaj koji se koristi za umetanje i učvršćivanje kanile ispod kože i prijenos
inzulina na mjesto umetanja putem cjevčica iz pumpe.

Koncentracija inzulina - Snaga ili vrsta inzulina koji je liječnik prepisao korisniku. To utječe na stopu
inzulina koju pumpa isporučuje. Ako se koncentracija inzulina u korisnika promijeni, potrebno je
reprogramirati uzorke bazalnog inzulina te maksimalne stope bazalnog i bolusa u pumpi.

Korak - Mjera inzulina koju postavite i koristite za isporuku putem značajke Easy Bolus.

Maksimalni bazalni inzulin - Maksimalna količina bazalnog inzulina koju će pumpa isporučiti u
danom trenutku. (Postavlja korisnik.)

Maksimalni bolus - Maksimalna količina inzulina u bolusu koji će pumpa isporučiti u danom trenutku.
(Postavlja korisnik.)

Mjerač - Medicinski uređaj za određivanje približne koncentracije glukoze u krvi. Mala kap krvi
postavlja se na jednokratnu testnu vrpcu koju mjerač očitava i koristi za izračun razine glukoze u
krvi. Mjerač zatim prikazuje razinu u mg/dL ili mmol/L.

Mogućnost mjerača - Značajka koja pumpi omogućuje primanje očitanja glukoze u krvi s povezanog
mjerača razine glukoze u krvi.

Normalni bolus - Trenutna isporuka određene jedinične količine inzulina.

Omjer razmjene - Količina inzulina potrebna za pokrivanje jedne (1) razmjene ugljikohidrata.
(Pogledajte također: omjer ugljikohidrata.)

Omjer ugljikohidrata - Količina ugljikohidrata koju pokriva jedna jedinica inzulina. (Pogledajte
također: omjer razmjene.)

Osjetljivost inzulina - Količina mg/dL (ili mmol/L) za koju jedna jedinica inzulina smanjuje razinu
glukoze u krvi (GK). (Podaci iz čarobnjaka Bolus Wizard.)

Područje ispod krivulje (engl. Area Under the Curve, AUC) - Označava količinu visokih i niskih
izboja određenih unaprijed postavljenim vrijednostima. Podaci o izboju označavaju frekvenciju
visokih ili niskih izboja. AUC upućuje na važnost događaja tako što prikazuje koliko su oni izvan
raspona te koliko dugo.

Podsjetnik za kalibraciju - Pumpa će automatski pokrenuti alarm mjerača razine glukoze u krvi do
HH:MM svakih 12 sati i tako signalizirati da trenutna vrijednost kalibracije nije valjana. Vrijednost
podsjetnika za kalibraciju jest vremensko razdoblje prije isteka trenutne kalibracijske vrijednosti
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prema kojoj korisnik želi podsjetnik za kalibraciju. Ako je, primjerice, podsjetnik za kalibraciju
postavljen na dva sata, alarm mjerača razine glukoze u krvi do HH:MM aktivirat će se dva sata prije
no što je potrebno izvršiti kalibraciju.

Postotak srednje apsolutne razlike (MAD%) - Predstavlja razinu točnosti pri kalibraciji senzora
prema očitanjima GUK-a s mjerača. Što je taj broj niži, to je veća točnost kalibracije. MAD% se
izračunava tako da se razlika između bliskih parova glukoze sa senzora i očitanja GUK-a s mjerača
dijeli s očitanjem GUK-a s mjerača, a zatim se izračuna prosjek svih parova.

Prekid - Funkcija pumpe koja zaustavlja svu isporuku inzulina. Isporuke trenutnog bolusa i/ili
početnog ciklusa se otkazuju. Isporuka bazalnog inzulina zaustavlja se do ponovnog pokretanja.

Prijenos - Postupak prijenosa podataka iz pumpe ili mjerača na poslužitelj sustava CareLink® Personal.

Priv. - Privremeno

Privremeni bazalni (priv. bazalni) - Privremeni jednokratni bazalni inzulin određene količine i
trajanja. Koristi se za ispunjavanje potreba za inzulinom za posebne aktivnosti ili uvjete koji nisu
dio normalne dnevne rutine.

Profil bazalnog inzulina - Stopa bazalnog inzulina s vremenom početka i završetka. Korisnik može
programirati nekoliko različitih profila u svoju pumpu uz različitu stopu bazalnog inzulina za svaki
profil tijekom 24 sata radi postizanja boljeg nadzora nad razinom glukoze.

RF - Radijska frekvencija (RF).

Ručni bolus - Dodatna stavka dostupna na izborniku BOLUS MENU kada je značajka čarobnjaka Bolus
Wizard aktivna. Metoda programiranja bolusa bez čarobnjaka Bolus Wizard.

Test A1C - Test za hemoglobin A1C koristi se za tumačenje razine glukoze u krvi tijekom određenog
vremenskog razdoblja.

Test HbA1c - Test za hemoglobin A1C koristi se za tumačenje razine glukoze u krvi ili prosjeka razine
tijekom razdoblja od dva do tri mjeseca.

Test na ketone - Ketoni su otpad koji se stvara kada je tijelo prisiljeno sagorijevati tjelesnu mast
umjesto glukoze radi dobivanja energije. To može biti znak nedostatka inzulina u tijelu. Test na
ketone mjeri količinu ketona koncentriranu u krvi ili urinu.

Upozorenje da je rezervoar na niskoj razini - Programibilno upozorenje koje se pojavljuje kada
određeni broj jedinica ostane u rezervoaru pumpe ili kada preostane određeno vrijeme prije
pražnjenja rezervoara.

Uzorak, standardni - Vaš normalni bazalni inzulin koji podržava svakodnevne aktivnosti. Kada je
značajka Patterns (Uzorci) isključena, pumpa koristi standardni (bazalni) uzorak.

Uzorci bazalnog inzulina - Korisnik može programirati do tri različita uzorka stope bazalne doze u
svoju pumpu za isporuku bazalnog inzulina: standardni uzorak, uzorak A i uzorak B. Za svaki uzorak
moguće je postaviti do 48 stopa bazalnog inzulina.

Veza
(1) Služi za isključivanje i postavljanje mogućnosti mjerača koja pumpi omogućuje primanje
očitanja glukoze u krvi s povezanog mjerača.
(2) Koristi se i u sustavu za referencu na hipertekstne veze. Kada kliknete hipertekstne veze, one
vas vode do nekog drugog mjesta u sustavu ili na neko drugo web-mjesto.

Značajka uzorka - Proširena značajka pumpe koja omogućuje programiranje dodatnih bazalnih
doza (uzorak A, uzorak B) koje podržavaju aktivnosti ili uzorke glukoze koji nisu dio vaše
svakodnevne rutine, no uobičajeni su dio vašeg životnog stila. Takve aktivnosti mogu obuhvaćati
sport jednom tjedno, promjenu navika spavanja tijekom vikenda ili hormonalne promjene tijekom
menstruacijskog ciklusa.

Zvuk bolusa - Pumpu je moguće programirati tako da korisnik čuje zvuk kada odabere količinu
inzulina u bolusu (0,5 ili 1,0 jedinica) za isporuku. To je korisno u situacijama kada je teško vidjeti
gumbe na pumpi.
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